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3D Architect Home Designer
3D  Architect  Home  Designer  lets  you  simultaneously  plan  and  visualize  your  creative  ideas  in  3D.  Unlike
many CAD products, you do not need specialist CAD knowledge to get the most from the software. Simply
place your construction elements, e.g. walls, doors, roof, stairs and windows, in the 2D project. With a single
mouse click you’ll instantly see these in a 3D environment. In this 3D environment you can also examine and
control illumination effects, add textures, materials and finishes and place and manipulate furniture objects.

Whether you’re a self-builder, builder, interior designer or home improver, 3D Architect Home Designer not
only provides high performance planning software, but also an effective instrument for presentations. Often,
substantial  differences  exist  between  a  project  plan  and  an  artist’s  3D  impression,  however,  3D  Architect
Home Designer' rendering and walkthrough in the building project will help you avoid errors arising from such
mistakes.

In  Construction  mode  you  work  with  the  building  project.  To  assist  your  construction,  you  have  a  ruler,
guidelines  and  a  grid.  High  performance  functions  let  you  quickly  place  windows,  doors  and  stairs  easily,
leaving  you  with  full  control  and  maximum flexibility.  The  roof  structure  also  works  with  a  3D  preview  and
supports major types of roofing. With a mouse click you can move into 3D Furnishing mode, which shows
you the building in a 3D photo-realistic view. Here you can plan the interior arrangement and environment. In
addition, 3D Architect Home Designer includes a catalogue of objects and textures. By simply using drag and
drop  you  can  place  wallpaper  on  walls  and  furniture  objects  into  living  spaces.  By  placing  lights  you  can
include  light  and  shadow  in  your  plan.  The  integrated  rendering  module  determines  photo-realistic
representations of light, shadows, and reflections.

Now you are familiar with 3D Architect Home Designer, convert your creative ideas and enjoy the interaction
of project design and construction, supported by a real-time visualization.

About this document

About this document

Whether you’re a complete beginner or already familiar with programs such as 3D Architect Home Designer,
this  documentation  has  useful  information  describing  in  detail  the  many  features  and  functions  available
within  3D  Architect  Home Designer.  To  enable  you  to  easily  identify  program functions,  menus  etc,  some
screenshots have been included to accompany text references. Please note screenshots are representative
and designed to indicate specific functions. Many have been produced through different stages of Arcon Evo
development  and  whilst  still  being  appropriate  to  the  described  function,  the  appearance  may  vary  slightly
depending  on  the  version  in  use  and  the  operating  system  you  are  running.  Please  also  note  that  3D
Architect  Home Designer  can  work  in  both  metric  and  imperial  measurements,  and  for  that  reason  some
screenshots in this documentation may display either.

3D Architect Home Designer has a graphical, user-friendly and intuitive interface however we do suggest that
you  work  through  the Getting Started Guide  located  in  the  Manuals  folder  installed  with  application.  For
further  support  you  can  read  or  consult  this  documentation  for  reference  and  ideas.  Additionally  you  will
always find useful support through our online channels.

This is reference documentation so whether you decide to read from start to finish before using the software
or refer to this documentation as and when required,  the choice is  yours.  We always recommend that  you
familiarize yourself with the program functions first before starting a project.

Menu references:

Options  >  Program…  This  is  an  example  menu  function  which  you  will  see  all  the  time  throughout  this
documentation.  This  example  means:  Left-click  with  your  mouse  button  on  the  Options  menu  which  will
open a menu selection containing a Program entry. Click Program which will then open a dialogue box with
the details and options for this menu entry.

The '…' that follows Program… is an indication that this option will open a dialogue box.
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Overview
While using 3D Architect Home Designer you will find many things in common with other Windows programs
and where possible, 3D Architect Home Designer makes use of standard Windows functions and dialog
boxes. Accordingly you will find familiar menu items such as File – New, File – Open…, and Edit functions
like Cut, Copy and Paste. Of course, the individual program functions and details are different being
adapted to the requirements of design and planning. If you have already worked with other Windows
programs, you will recognize the basic operation of the Windows user interface. For example, how to select a
menu option from a menu, how to open and minimise windows, and how to launch and exit a program. If
these operations sound unfamiliar, or if you are not comfortable with the Windows user interface, take a look
at your Windows documentation.

If you have used previous versions of Arcon, the basic principles and operation will look familiar. However the
toolset, options and menu interface will not be exactly the same, so we would recommend taking time to
familiarize yourself with this version of 3D Architect Home Designer.

Construction, 3D Furnishing and Plan Modes

3D  Architect  Home  Designer  makes  use  of  multiple  on-screen  modes  to  enable  different  views  to  be
displayed and tasks to be performed. The use of these differing modes enables the toolset in use with each
mode to be flexible and appropriate, meaning 3D Architect Home Designer can be quick and easy to learn
and use.

The three basic modes in 3D Architect Home Designer are:

2D Construction Mode is used to create the structure and layout of the building. Working in a 2D top-down
view, the tools in Construction Mode are the primary elements required to create a building.

 Toggles the view to the 2D Construction Mode. The blue bar indicates the current mode. Please be
aware that many tools and functions are related to the current mode in 3D Architect Home Designer.
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3D Furnishing Mode can be accessed at any time to view the project you are working on in 3D. The main
use  of  the 3D Furnishing Mode  is  to  add  furniture,  fixtures,  fittings  and  decoration  with  a  combination  of
objects and textures from the catalogue.

 Toggles the view into the 3D Furnishing Mode.  Please be aware that many tools and functions are
related to the current mode in 3D Architect Home Designer.
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Plan Mode  is  a  layout  view which  enables  you  to  select  multiple  different  views  of  your  building  including
floor plans, elevations, 3d views and visualizations and add them all to a single page.

 Toggle the view into Plan Mode to enable multiple views and different layouts to be combined in a plan
view. Please be aware that many tools and functions are related to the current mode in 3D Architect Home
Designer.
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Display and Interface Overview

1. Tool Menu Bar

2. Tool Placement Context Bar

3. Standard Menu Bar

4. Horizontal Icon Bar

5. Tool Options / Objects Catalogue

6. Main Worksheet

7. Status Bar

8. Numeric Input

9. Tool Options Header Bar

Basic Mouse & Keyboard Controls
In 2D Construction mode and 3D Furnishing mode you can use various mouse and keyboard controls for

zooming, viewing from all angles, moving about screen and walkthroughs.

· Mouse & Keyboard Controls: 2D Construction Mode

· Mouse & Keyboard Controls: 3D Furnishing Mode
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2D Construction Mode
Here are some basic mouse and keyboard controls to help you navigate your way round in 2D construction

mode:

· Hold down right-mouse button

This will shift the floor plan view when moving mouse

· Move the mouse wheel

This allows you to zoom in and out to selection

· Left mouse button and selection tool  

Use to select menus, elements and tools.

Note: This same selection tool can also be used for zooming by selecting this in the Tool Options circled

below.

· Right mouse button

Opens available context menu for element under cursor
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3D Furnishing Mode
Here are some basic mouse and keyboard controls to help you navigate your way round in 3D Furnishing

mode:

· Hold down right-mouse button

Allows you to rotate and view 3D building from every side when moving mouse

· Hold down the right mouse button and Shift key

This will shift the 3D building from side to side when moving mouse

· Hold down the right mouse button and Ctrl key

This will rotate 3D building around reference point when moving mouse

· Move the mouse wheel

Allows you to zoom in and out to selection

· Left mouse button and selection tool 

Use to select menus, elements and tools.

Note: This same selection tool can also be used for zooming by selecting this in the Tool Options circled

below.

· Right mouse button
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Opens available context menu for element under cursor

· Walkthrough mode 

Press down left mouse button and move mouse in direction to speed up walkthrough.

The icon will change depending on direction.

Pressed left mouse button, Shift key and move mouse in direction to increase speed

Move

forwards

Move

backwards

Move

forward

left

Move

forward

right

Move

left

Move

right

Turn left Turn right

   

Drag and Drop

For ease of use, 3D Architect Home Designer employs the drag-and-drop concept to many of the programs
tools  for  example  furnishing  objects,  2D symbols  or  construction  elements  such  as  supports  or  chimneys.
This enables you to select an element (often from the Tool Options Catalogue) by left-clicking the mouse
button. Then drag the element to the desired location on the page and left-click the mouse button again to
drop the element into that location.

In addition to the standard use of drag and drop, elements which require a start and end point to be defined
(e.g. walls) will make use of left-click to place the first point (i.e. the start point for a wall) and then left-click
again to set the end point. Other elements such as a staircase will require 3 placement clicks to determine
size and orientation.

Many of the tools accessed from the Tool Menu Bar have placement options. This can be used to decide
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the placement method of item you are trying to create. If such options are available, you will see the dynamic
Tool Placement Context Bar will be displayed on the inside of the left Tool Menu Bar or on the inside  of
the right Tool Options Catalogue. There are a number of tools that include the polygonal input method such
as  roofs  or  ground  area  for  example  therefore,  the  number  of  placement  clicks  depend  on  the  type  of
element.

See also Basic Mouse & Keyboard Controls

Selecting Tools

To select a tool from the relevant tool bar, menu or catalogue, move your cursor over the required option and
left-click (click the left mouse button once). For easy access, tools also display a a fly-out menu of recently
used items or those included in main catalog when you hover your mouse cursor over the icon.

When  referring  to  tool  options  in  the  catalogue  area,  those  icons  identified  with  a  small  windows  folder
symbol can be accessed by left-clicking to reveal the subset of options.
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See also Basic Mouse & Keyboard Controls

Tool Placement Context Bar

Many of the tools accessed from the Tool Menu Bar have different placement options. This can be used to
decide the placement method of item you are trying to create. If such options are available, you will see the
dynamic Tool Placement Context Bar will be displayed on the inside of the left Tool Menu Bar

The  same  placement  methods  also  become  appear  and  become  active  on  the  inside  of  the  right  Tool
Options Catalogue next to the catalog items. 
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See also Basic Mouse & Keyboard Controls

Vertical Tool Menu Bar (Left)

The standard Tool menu bar is located on the left side of the screen. This vertical toolbar contains the icons
for all of the tools available for the mode you are currently working in. Hover your mouse over these icons to
see sub-options for the tool. Left-click on the icon to select the required tool. Not all tools can be used across
all three modes (2D Construction, 3D Furnishing, Plan mode) therefore, some icons in the Tool menu bar will
be greyed out and no longer active whilst in this mode.

2D Construction mode tool menu 3D Furnishing mode tool menu Plan mode tool menu
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See also Display and Interface

Horizontal Icon Bar (Top)
As with other Windows programs 3D Architect Home Designer consists of a menu bar at the top of the
screen for convenient access to various operations within the program. 

Besides the menu bar is the horizontal toolbar. These bars consist of arranged sets of icons, which serve to
access program functions or change the view. The individual icons on the bars behave similarly to icons in
Windows programs. By left-clicking them you can activate or deactivate functions.
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In the horizontal bar that appears at the top, under the classic menu bar, you’ll find icons which are used
throughout the whole project.

The horizontal bar comprises of an arrangement of general functions as follows: 

· Open file 
· Save file 
· Undo & Redo
· Print
· Export image 
· Zoom 
· Show all 
· Toggle between 2D and 3D and Plan mode 
· Move texture 
· Material/texture picker 
· Active layer display
· Active floor display
· Tool options 
· Brightness level (3D only)
· Catalogue on/off 
· Quick help 

Tabs for accessing properties also become visible on selection of construction elements and tools - see Tool
Options Header

Tool Options Header Bar

Selecting  a  tool  from  the  Tool  Menu  Bar  will  display  the  customization  options  for  this  tool  in  the  Tool
Options Header Bar. On the same top Icon bar, the options will display to the right of the Layer and Floor
selection drop down menus. The number of options displayed will  vary for each tool  and additional options
may become available if you select an element that has already been inserted in to your drawing.

 Stairs  Dimensions

Each option can be selected by left-clicking to open its associated dialogue box before and after placement.

Note:  If  the  area of  the header  available  to  display  the  Tool  Options  Header  Bar  is  not  large  enough  to
show  all  the  options  for  the  selected  tool,  due  to  screen/window  size,  the  options  will  convert  into  a  drop
down menu.

See also Display and Interface

Selection Tool
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Tool Options / Objects Catalogue (Right)

The  Tool  Options  /  Objects  Catalogue  displays  the  stored  profiles  for  the  chosen  tool,  construction
element, object, symbol or texture. Here you can select the type of tool/element and style by selecting from
one  of  the  preset  options  in  the  database.  These  properties  can  then  be  further  edited  before  or  after
placement by making changes in the The Tool Options Header Bar.
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In the catalog, those icons identified with a small yellow windows folder symbol e.g.   can be
accessed by left-clicking to reveal the subset  of  options.  Depending on what tool  you are accessing,  there

could be further sub-folders to click. With the following icon (see below) you can move up one folder in

the directory structure. By clicking the  icon you always move first  into  the folder  that  was last  opened

and by clicking the icon next to it  returns you back to top of directory.

By left-clicking the hierarchy icon (circled below) in the catalog panel, all items associated with tool including
those in sub folders can be expanded allowing for all items to be viewed together e.g. below.
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A  list  view  of  smaller  thumbnails  with  labels  next  to  catalog  items  are  also  available  by  left-clicking  the
'Details' symbol next to hierarchy symbol.

See also Editing Tools
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Status Bar

The Status Bar, which shows at the bottom of the screen, contains a series of toggle buttons to hide or show
particular  elements  and  features  with  3D  Architect  Home  Designer.  The  functions  of  the  Status  Bar  are
replicated  within  the  standard  menus  but  are  provided  here  as  quick  access  icons  for  the  most  common
functions. The exact contents of this area can be customized - see Configure Status Bar

The status bar also displays tips or a sequence of steps on how to use certain tools for example placing a
wall or positioning a window in a wall. On selection of some tools and construction elements, options specific

to that tool/element are available by clicking the icon   in the horizontal icon bar at top.

See also Display and Interface

Rooms

Rooms are defined as enclosed spaces and are automatically  defined and  identified  by  enclosing  an area
with connected walls. Once a room is created, it will automatically be labelled (e.g. Room 1) to show that the
space if fully enclosed and that the walls have been correctly joined. Once a space is defined as a room, its
floor and ceiling are added automatically by 3D Architect Home Designer.

You can use the Room Data options to re-label each room by clicking on a completed room to select it and
then choosing the Room Data option from the Tool Options Header Bar.

Floors

Floors consist of one or more rooms on the same level of a building. Each floor will be defined by the same
height information meaning the rooms on a single floor will always share the same height above ground level
and floor-to-floor height.

Adding additional  floors enables multi-storey buildings to be created.  Each floor  is  completely  independent
enabling different height settings to apply on different floors. Floors in 3D Architect Home Designer stack in
the same way that they do in real buildings, this enables you to view a multi-floor building instantly in 3D.

Buildings

Buildings are constructed from one or more floors, containing one or more rooms. It is also possible to use
multiple buildings to create single designs where floors need to be split  level or of differing ceiling and wall
heights.
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Standard Menu Bar
As with other Windows programs 3D Architect Home Designer consists of a menu bar at the top of the
screen for convenient access to various operations within the program. 

File

Edit

Furnishing

View

Project

Floors

Layers

Options

Display

Window

File
New

Open

Search

Sample Project

Open From Clipboard

Open Last Project

Save

Save As

Close

Import

Export

Print

Print Setup

Recently Opened Files

Exit
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New

Creates a New  blank project to begin drawing on. If  you have Use Project Assistant  selected in Options
this will launch the project assistant dialogue e.g. below. 

If  this  option  is  not  selected,  a  new  blank  drawing  page  will  be  created  instead  using  default  project
properties. These properties can be changed through the menu Project > Project Properties.  Sheet size,
scale etc can be changed in this dialog box at any point in your project.
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Open
Open an existing 3D Architect Home Designer project. Launches a standard Windows file browser dialogue
to enable you to locate the saved 3D Architect Home Designer (.anp)  file.  Select  the required file  and left-
click on Open.

You can also use the  icon on the top horizontal toolbar to perform the Open function.

Search

The Search function can be used to locate a file containing particular word or name in a specific folder.

Sample Project

We provide a selection of Sample Project files which can be selected and opened with this option. These
sample projects help to give an insight into how a project is constructed and can be used as a quick way to
experiment with a tool or feature.

Open From Clipboard

If you have cut/copied a 3D Architect Home Designer drawing from another file, Open From Clipboard will
enable you to create a new project from the contents held in your Windows clipboard. The drawing details
held in the clipboard will automatically be pasted into the new project.

Open Last Project
Open the last saved project that you worked on. This option will only open projects which have been saved
and cannot be used to recover a project which you have worked on but did not save.

Save

When you initially Save  your file, you will be prompted by an standard Windows dialogue box to select the
location to save the file and to enter a filename. Each subsequent save of the file will use the same filename
and location.

You can also use the  icon on the top horizontal toolbar to perform the Save function.

Save As
Save As enables you to select a new filename and/or location to save an existing project. It is generally good
practice  to  save  multiple  versions  of  your  files  as  you  work  on  them  so  that  you  can  revert  to  an  earlier
version if you need to.

Close
Close  the currently open and active project file. If you choose to close the file without saving, you will  lose
any changes you have made since the last Save. When you choose to Close a file, you will be prompted to
confirm if you wish to save the file or not.
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Import
Image File

Project File

Scan Assistant

Image File

Image Files can be imported to add to your drawings. This could be for adding a logo or supporting image to
your plan or an image you wish to use as template for a layout drawing. Images can be imported in the most
common file formats (bmp, jpg, png) and once imported can be scaled, rotated and moved on the page.

Project File

Import Project Files from other applications in supported file formats. These imported files can then be used
as the basis for your drawings in 3D Architect Home Designer.

DXF/DWG Import Assistant

The Import Assistant supports the latest DXF/DWG file formats allowing you to load in location plans for
submitting with planning applicatins or applying CAD detail blocks for building regulations. The assistant also
allows you to create a project based on work from another CAD program. These files can be loaded and be
used like guidelines, so you can for example, snap walls and other construction elements making it easier
and quicker to draw up your floor plans in 3D Architect Home Designer

To load a DXF/DWG file, select the menu File > Import > DXF/DWG Important Assistant. A dialog box
appears.

A preview of file will display selected number of layers listed in Layers window. The layer preview can be
zoomed in an out with the mouse wheel and also moved about with mouse with left mouse button held down.
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Scan Assistant

Use the Scan Assistant  to link directly to your TWAIN compatible scanner or  import  directly  from existing
image file. Using the simple wizard, you can then scan an existing paper copy of a plan or drawing from your
scanner  directly  into  3D  Architect  Home Designer  or  just  use  it  to  import  an  existing  image  file  to  use  as
background image for tracing over.

Step 1: Load Image
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Step 2: Optimize image settings
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Step 3: Adjust alignment
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Step 4:  Determine scale  through two points.  For  more accuracy,  use the  Zoom drop down,  mouse
wheel or type in value to zoom in to image
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Step  5:  Define  snap  points  with  slider.  You  can  determine  level  of  snap  points  on  image  to  allow
construction elements to snap to image more easily when tracing/drawing over background image.
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Export
In both 2D Construction mode and 3D Furnishing mode you can export views and project file to a number of
different file formats through the menu File > Export

These include:

Image File

DXF

DWG

PDF

DAE (Collada)

KMZ (Google Earth)

o2c Object

STL (3D Printing)

POV (Pov-Ray Scene)

Additional option to Email project direct
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Image File

Exports the current on-screen view to an Image File.  All standard image file types are supported including
png, jpg, bmp and tif.

In  2D  Construction  mode,  you  will  be  presented  with  the  following  dialog.  Here  you  can  set  the  image
resolution and what view to export e.g. part of plan view currently shown on screen or entire plan. Clicking
OK will open the standard Windows Save as dialog where you can select a file type.

In 3D Furnishing mode you will be presented with slightly different dialog box. Here you can set the image
size of 3D view either as current view shown on screen or by defining pixel dimensions.

In the Image quality section there is a drop down list of options for oversampling including without, 4-times,
9-times, 16-times. With oversampling selected, each pixel is measured against neighboring pixels, and the
display and coloring is adapted accordingly. The result is that edges are smoothed and colors display more
vibrant. The higher the oversamplng the bigger the file size will be when exported.

Clicking OK with open another dialog box where you can make edits to image e.g. brightness and contrast
levels. Clicking OK will open the standard Windows Save as dialog where you can select a file type.
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You can also use the  icon on the top horizontal icon bar to perform the Export Image File function.

o2c Object

The o2c Object export allows you to export your 3D models in the Eleco’s compact and high-speed o2c file
format that can be emailed across to clients for example. These o2c models can then be shared easily and
opened by anyone running one of our free o2c player options including our PC based player, iPad viewer and
our cloud based o2c player.

For more information on the o2c player please see our dedicated o2c website at www.o2c.de/en

Print

3D Architect Home Designer lets you Print  plan views, elevations or perspective views directly to a printer.
Plan views are printed at a scale you specify, and perspective views at an adjustable size. In 2D you open
the standard Windows print dialogue box, where you can select the printer, adjust print options according to
the selected printer, select the number of copies, and so on. In 3D there are additional options to select the
background colour and print resolution of the image.

You can also use the  icon on the top horizontal toolbar to perform the Print function.

Print Setup
Print Setup launches a standard Windows dialogue box for you to select the printer, paper size and paper
orientation required when you want to print  your drawings. It  is also possible  to select  a PDF printer  driver
here instead of a physical printer. The options available to you will depend upon the printer selection installed
on the computer you are using.

Recently Opened Files

Shows a list of the most Recently Opened Files to enable quick access to these files for re-opening.

Exit

Closes 3D Architect Home Designer. When you select Exit you will be prompted to save the file is you have
made any changes to the current project since you last saved the file. You can also exit 3D Architect Home
Designer using the standard Windows close window icon.

Edit
Undo

Redo

Cut

Copy

Paste

Delete

Tools

Select Properties

http://www.o2c.de/en
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Transfer Properties

Group

Ungroup

Align

Place on Sheet

Order

Extrude

Convert Rooms into Individual Walls

Properties

Undo

Clicking Undo  reverses the most recent action, reverting your drawing to the state prior to the last action.  
Undo  can  be  used  multiple  times;  each  click  will  reverse  the  previous  command.  This  enables  you  to
rollback a complete editing session if required.

You can also use the  icon on the top horizontal toolbar or the keyboard shortcut CTRL + Z to perform
the Undo function.

Redo
Redo will only be available once an Undo command has been used. Redo reverses the action of a previous
undo,  enabling  you  to  remove  and  subsequently  repeat  a  command.  A  Redo  will  be  available  for  every
equivalent undo used in an editing session.

You can also use the  icon on the top horizontal toolbar or the keyboard shortcut CTRL + Y to perform
the Redo function.

Cut
Cuts the currently selected element, removing it from the plan. When you cut something, it is deleted from its
current  location  and  saved  to  the  clipboard.  Information  saved  to  the  Clipboard  stays  there  until  new
information is either cut or copied. Each time you execute cut or copy, you replace the old information on the
clipboard with whatever you just cut or copied. You can paste the same clipboard information as often as you
like.

You can also use the standard keyboard shortcut CTRL + X to perform the Cut action.

Copy
Copy  duplicates  the  currently  selected  element  but  does  not  delete  it  from  the  plan.  When  you  copy
something, a copy of the item is saved to the clipboard. Information stored on the clipboard stays there until
new information is either cut or copied. Each time you execute cut or copy, you replace the old information on
the clipboard with whatever you just cut or copied. You can paste clipboard information as often as you like,
until you replace it with something else.

You can also use the standard keyboard shortcut CTRL + C to perform the Copy action.
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Paste
Paste places the information currently held in the clipboard onto the selected drawing area. You can place
information  on  the  clipboard  wherever  you  like.  Use  the  paste  command and  information  you  have  cut  or
copied is placed wherever your cursor is located.

You can also use the standard keyboard shortcut CTRL + V to perform the Paste action.

Delete
All

Active Layer

Select Layer

Active Floor

Select Floor

Group

Selection

All

Deletes All elements of the current active project.

Active Layer

Deletes all elements of the active Active Layer of the active project.

Select Layer

Deletes all elements of the Selected Layer of the active project. Choosing this option opens a dialogue box
with a list of all  applicable layers, from which you can select the layer (or layers by using CTRL + Click or
 Shift + Click) from which to remove elements.

Active Floor

Deletes all elements of the active Active Floor of the active project.

Select Floor

Deletes all elements of the Selected Floor of the active project. Choosing this option opens a dialogue box
with  a list  of  all  applicable  floors,  from which  you  can  select  the floor  (or  floors  by  using CTRL +  Click or
Shift + Click) from which to remove elements.

Group

Deletes all elements of the selected Group of the active project. Choosing this option opens a dialogue box
with a list of all applicable groups, from which you can select the group (or groups by using CTRL + Click or
Shift + Click) from which to remove elements.

Selection

A Selection of elements on a specific plan can be made using either a selection rectangle, a single left-click
or  left-click  combined  with  Shift/CTRL  to  highlight  multiple  elements.  Once  one  or  more  elements  are
selected, the delete selection option can be used to remove the selected elements from the project.  Using
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the Delete (Del) key on your keyboard will also perform the Delete – Selection function.

Tools
Modify Walls
L-Trim (Miter walls)
T-Trim (Join walls)
Length (Wall)
Break (Wall)
Trim/Bevel
Trim Line
Trim Line to Circle or Ellipse
Trim Circle to Line
Trim Circle
Round Off Corner
Bevel Corner
Segments/Breaks
Delete Segment of Line
Divide Into Equal Segments
Drag Line
Delete Segment of Circle, Ellipse or Arc
Circle Break
Convert Arc to Full Circle
Fills/Hatching
Fill Item
Remove Fill
Hatch Element
Move/Rotate/Mirror
Move
Copy
Stretch
Stretching a section of floorplan / building
Rotate
Free Rotate
Mirror Horizontally
Mirror Vertically
Mirror
Copy
Multiple Copy in Row
Multiple Copy over Multiple Rows
Circular Multicopy
Circular Multicopy & Rotate
Polygons/Splines
Add Spline Points
Delete Spline Points
Edit Spline Points

Modify Walls

The wall modification tools enable you to edit existing walls in your project.

L-Trim

T-Trim

Length

Break
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These tools are also accessible in the Tool Options Catalog by clicking the Editing Tools icon  on the
 Tool Menu Bar.

See also 2D Editing Tools

L-Trim (Miter walls)

This menu option functions in the same way Miter Walls tool  and is used to miter together two
adjacent walls at a corner. Generally, walls will be automatically connected and mitered when using the wall
tools to create a room area.

See Miter walls (L)

1. Select the menu option for L-Trim ( Edit > Tools > Modify Walls > L-Trim)

2. In  your  drawing,  left-click  on  one  wall  and  then  left-click  on  the  other  wall  to  join  the  walls  without  any
overlapping. 

In the walls section see also

Trimming walls together

T-Trim (Join walls)

This  menu  option  functions  in  the  same  way  as  the  Join  Walls  tool   and  is  used  to  miter
together two adjacent walls where a wall end meets a long wall edge. Generally, walls will  be automatically
connected and mitered when using the wall tools to create a room area.
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See Join walls (T)

1. Select the menu option for T-Trim ( Edit > Tools > Modify Walls > T-Trim)

2. In your drawing, left-click on the wall that you’d like to join to another wall, then simply left-click on the wall
you’d like it to be joined to. 

Length (Wall)

This menu option functions in the same way as the Wall Length tool  and is used to increase
or decrease the length of an existing wall in a project drawing.

See Wall length

Reduce length of wall using the Wall length tool

1. Select the menu option for Length ( Edit > Tools > Modify Walls > Length)

2. Hover the cursor over the wall where it should highlight green.

3. To reduce the length of a wall, left click on the edge of the wall (e.g. arrow 1) then left-click on the part of
the wall you’d like it to be reduced to (e.g. arrow 2). 
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Note: Click the Esc key on your keyboard to de-select everything before continuing.

Increase length of wall using the Wall length tool

1. Select the menu option for Length ( Edit > Tools > Modify Walls > Length)

2. Hover the cursor over the wall where it should highlight green.

3. To increase the wall  length;  left-click  the edge of  wall  (arrow 1)  where it  ends and drag the wall  to  your
desired position (arrow 2). For precise wall lengthening, once you have left-clicked on the edge of the wall,
drag the wall  in the direction you’d like to extend it  then before left-clicking to secure the wall’s  position,
use your keyboard and type in desired length. Press the Enter  key or click the Apply  button in  numeric
input bar.



Standard Menu Bar

36

Break (Wall)

This  menu  option  functions  in  the  same way  as  the  Wall  Break  tool   and  is  used  to  split  an
existing wall on a project drawing into two separate walls.

See Wall break

1. Select the menu option for Break ( Edit > Tools > Modify Walls > Break)

2. Diagram 1: To make a break in a wall in order to create two separate walls that are still  joined together,
you must left-click once on the wall you’d like to break and then left-click once on the exact section of the
wall you’d like the break to be.

3. Diagram 2: Now the break has been made, if you click on the right hand side of the wall, you’ll be able to
see the new separate wall segment highlighted.

4. Diagram 3: By left-clicking the left side of the wall, it will show you the other wall segment.

Trim/Bevel

Trim Line

Trim Line to Circle or Ellipse

Trim Circle to Line

Trim Circle

Round Off Corner

Bevel Corner
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These tools are also accessible in the Tool Options Catalog by clicking the Editing Tools icon  on the
 Tool Menu Bar.

See also Editing Tools

Trim Line

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Trim Line tool allows you to
tidy overlapping lines by trimming them to connect together neatly.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Trim Line to Circle or Ellipse

Used  to  edit  line  elements  drawn  on  the  plan  using  the  2D  Drawing  Tools,  the  Trim  Line  to  Circle  or
Ellipse tool allows you to trim a line into an adjoining circle or ellipse, tidying overlapping lines by trimming.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Trim Circle to Line

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Trim Line Circle to Line tool
allows you to trim a circle at the point where it is intersected by a line, removing a section of the circle where
it does not adjoin the line.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar
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In the Tool Options Catalog, open the  folder and left-click the  tool.

Trim Circle

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Trim Line Circle tool allows
you to trim a circle at the point where it is intersected by another circle, removing the sections of the circles
where they intersect, creating a single shape.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Round Off Corner

Used  to  edit  line  elements  drawn  on  the  plan  using  the  2D  Drawing  Tools,  the  Round  Off  Corner  tool
allows you to replace an angled corner with a curved, rounded corner. Use the Tool Options Header Bar to
set the radius of the curve.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Bevel Corner

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Bevel Corner tool allows you
to replace an angled corner with a bevelled corner.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.
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Segments/Breaks

Delete Segment of Line

Divide Into Equal Segments

Drag Line

Delete Segment of Circle, Ellipse or Arc

Circle Break

Convert Arc to Full Circle

These tools are also accessible in the Tool Options Catalog by clicking the Editing Tools icon  on the
 Tool Menu Bar.

See also Editing Tools

Delete Segment of Line

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Delete Segment of Line tool
allows you to select a line on the plan and define a section of this line to remove.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Divide Into Equal Segments

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Divide into Equal Segments
tool allows you to select a line on the plan and split  it  into a number of lines of equal length. Use the Tool
Options Header Bar to set the number of lines to split into.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.
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Drag Line

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Drag Line tool allows you to
select a line on the plan and create a ‘pull point’ which can then be dragged to a new location. The existing
line will then reshape to form an angled line, with the original two end points remaining in place.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Delete Segment of Circle, Ellipse or Arc

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Delete Segment of Circle,
Ellipse or Arc tool allows you to select a circle, ellipse or arc on the plan and define a section to remove.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Circle Break

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Circle Break tool allows you
to select a circle on the plan and split it into sections.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Convert Arc to Full Circle

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Convert Arc to Full Circle
tool allows you to select an arc on the plan and complete the line to create a fully enclosed circle.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar
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In the Tool Options Catalog, open the  folder and left-click the  tool.

Fills/Hatching

Fill Item

Remove Fill

Hatch Element

These tools are also accessible in the Tool Options Catalog by clicking the Editing Tools icon  on the
 Tool Menu Bar.

See also Editing Tools

Fill Item

Used to edit line elements drawn on the plan using the 2D Drawing Tools,  the Fill Item  tool allows you to
select a shape and add a colour fill to it using a combination of fill styles, images, colours and line types. Use
the Tool Options Header Bar to set the fill style e.g.
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This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Remove Fill

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Remove Fill tool allows you
to select a shape and remove the colour fill, leaving only the outline and any hatching pattern.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.
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Hatch Element

Used to edit line elements drawn on the plan using the 2D Drawing Tools, the Hatch Element  tool allows
you to select a shape and add a hatching pattern to it. Use the Tool Options Header Bar to set the hatching
pattern. e.g.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Move/Rotate/Mirror

Move

Copy

Stretch

Rotate

Free Rotate

Mirror Horizontally
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Mirror Vertically

Mirror

These tools are also accessible in the Tool Options Catalog by clicking the Editing Tools icon  on the
 Tool Menu Bar.

See also Editing Tools

See also Stretching a section of floorplan / building

Move

Select one or more 2D elements from your plan, the Move tool can then be used to re-locate these elements
in  your  drawing.  Giving  more  control  that  moving  manually,  the  Move  tool  allows  you  to  specify  an  origin
point to assist in the re-location of the elements relative to the defined point.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Copy

Select one or more 2D elements from your plan, the Copy tool  can then be used to copy and paste these
elements  elsewhere  in  your  drawing.  The  Copy  tool  allows  you  to  specify  an  origin  point  to  assist  in  the
placing the copied elements on the plan.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Stretch

Select one or more 2D elements from your plan, the Stretch tool can then be used to re-size these elements
by stretching the dimensions.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar
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In the Tool Options Catalog, open the  folder and left-click the  tool.

See also Stretching a section of floorplan / building

Stretching a section of floorplan / building

In 3D Architect Home Designer it’s very simple to ensure you get a floor plan laid out accurately using any of
the various techniques. However on occasion you may want to ‘pull’ a section of a floor plan to change the
size of an area without affecting the adjoining walls and rooms. 
The Stretch tool allows you do this in a few simple steps.

1) With the walls in already place, in the Tool Options Catalog, open the  folder and left-click

the  tool.

2) The Stretch tool utilizes a standard polygon area to define which part of the building is included in the
stretch area. Anything not included in the polygon will be left in its current position.
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3) With the Stretch tool selected, using the mouse to click each corner of the polygon, select the area to be
included in the zone to be ‘pulled’.

.

4) When the area has been defined, press Esc on your keyboard to lock the area.

5) Now, simply click on one of the included elements e.g. outside edge of wall and move your mouse
outwards or inwards to where you want to stretch it to. You will see the effect of the movement on-screen.

Note, you can also use the numeric input to determine how much you want to stretch it to by simply typing
value direct. This value will be update Distance field (highlighted blue) in numeric input bar at bottom of
screen. You can also use other methods such as guidelines to mark out new distance.
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6) With the wall in it the new location, left-click to place it or press the Return key if you have entered
distance using numeric input. The room has now been stretched to its new size.

7) Try combining this technique with the use of guidelines and/or rulers to ensure accurate re-placement of
the selected elements.
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Rotate

Select one or more 2D elements from your plan, the Rotate tool can then be used to rotate these elements
freely around the centre point of the selected element(s)

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Free Rotate

Select one or more 2D elements from your plan, the Rotate tool can then be used to rotate these elements
freely around a defined origin point.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Mirror Horizontally

Select one or more 2D elements from your plan, the Mirror Horizontally tool can then be used to create a
mirrored (i.e. inverted horizontally) copy of these elements elsewhere in your drawing. The horizontal plane is
used to set the location for the paste position of the mirrored elements.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Mirror Vertically

Select  one  or  more  2D elements  from your  plan,  the  Mirror  Vertically  tool  can  then  be  used  to  create  a
mirrored  (i.e.  inverted  vertically)  copy  of  these  elements  elsewhere  in  your  drawing.  The  vertical  plane  is
used to set the location for the paste position of the mirrored elements.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar
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In the Tool Options Catalog, open the  folder and left-click the  tool.

Mirror

Select one or more 2D elements from your plan, the Mirror tool can then be used to create a mirrored (i.e.
inverted) copy of these elements elsewhere in your drawing. The free-hand plane is used to set the location
for the paste position of the mirrored elements.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Copy

Multiple Copy in Row 

Multiple Copy over Multiple Rows

Circular Multicopy

Circular Multicopy & Rotate

These tools are also accessible in the Tool Options Catalog by clicking the Editing Tools icon  on the
 Tool Menu Bar.

See also Editing Tools

Multiple Copy in Row

Select one or more 2D elements from your plan, the Multiple Copy in Row tool can then be used to create
a  row  of  X  number  of  copies  of  the  selected  element(s)  in  a  single  row,  placed  adjacent  to  the  original

element. Use the Tool Options icon  to define the number of copies in the row.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar
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In the Tool Options Catalog, open the  folder and left-click the  tool.

Multiple Copy over Multiple Rows

Select one or more 2D elements from your plan, the Multiple Copy  over Multiple Rows  tool  can then be
used to create a row of X number of copies of the selected element(s) in multiple rows, placed adjacent to

the original  element.  Use  the Tool  Options  icon  to  define  the  number  of  copies  in  the  row  and  the
number of rows.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Circular Multicopy

Select one or more 2D elements from your plan, the Circular Multicopy tool can then be used to create X
number of copies of the selected element(s) in a circular path from the centre of the original element(s). Use

the Tool Options icon  to define the number of copies placed around the circle.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Circular Multicopy & Rotate

Select one or more 2D elements from your plan, the Circular Multicopy & Rotate tool can then be used to
create  X  number  of  copies  of  the  selected  element(s)  in  a  circular  path  from  the  centre  of  the  original
element(s), rotated to ensure they are at the same angle to the circle as the original element. Use the Tool

Options icon  to define the number of copies placed around the circle.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar
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In the Tool Options Catalog, open the  folder and left-click the  tool.

Polygons/Splines

Add Spline Points

Delete Spline Points

Edit Spline Points

These tools are also accessible in the Tool Options Catalog by clicking the Editing Tools icon  on the
 Tool Menu Bar.

See also Editing Tools

Add Spline Points

Add Spline Points to an existing 2D spline, creating an additional control point for re-shaping or amending
the existing shape.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Delete Spline Points

Delete  Spline  Points  from  an  existing  2D  spline  element,  removing  a  control  point  for  re-shaping  or
amending the existing shape.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar
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In the Tool Options Catalog, open the  folder and left-click the  tool.

Edit Spline Points

Edit  Spline  Points  from  an  existing  2D  element,  change  a  control  point  for  re-shaping  or  amending  the
existing shape.

This same function is also accessible in the Tool Options Catalog by clicking the Editing Tools icon 
on the Tool Menu Bar

In the Tool Options Catalog, open the  folder and left-click the  tool.

Select Properties
The properties  (size,  colour,  depth,  line  type  etc.)  of  the  selected  element  are  copied  so  that  they  can  be
applied to other instances of the same element using Transfer Properties.

Transfer Properties

Applies the properties (size, colour, depth, line type etc.) copied from an element using Select Properties to
other selected instances of the same element.

Group

You can Group multiple objects together once you have selected more than a single object (either by Shift +
Click or the selection rectangle method). When you create a Group  you will be prompted to name it,  once
named the objects in the group will be treated as if they were a single object with a single selection frame. A
group can then be moved, deleted, copied, rotated etc. as a single entity.

You can also create groups of groups in the same method. A Group can also be made by using the  icon
which appears on top of your selection frame once you select more than one object.

Ungroup
Ungroup  splits  a group of  objects  back to their  individual  components.  Once ungrouped objects  are  once
again treated as single entities. If you have created a group of groups, the ungroup command will only split
the largest group, you would then need to repeat the command for the component groups as required.

You can also Ungroup an existing group by using the  icon which appears on top of your selection frame
once you select an existing group.
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Align
These functions are active only if you’ve selected at least two objects or groups of objects. If only one object
is selected, or if no object is selected, this button is inactive and greyed out.

Left

Right

Behind (Top)

Front (Bottom)

Top

Bottom

Centre

Front-Back

Left-Right

Top-Bottom

Left

Aligns selected items on sheet to the Left edge.

Right

Aligns selected items on sheet to the Right edge.

Behind (Top)

Aligns selected items on sheet to the Top edge in 2D or Behind each other in 3D.

Front (Bottom)

Aligns selected items on sheet to the Bottom edge or in Front of each other in 3D.

Top

Aligns the Top edges of selected items in 3D.

Bottom

Aligns the Bottom edges of selected items in 3D.

Center

Aligns selected items Center points.

Front-Back

Align the Fronts and Back edges together. If the selected items are of different sizes, the smaller item will
be aligned spaced evenly between the front and back of the larger item.
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Left-Right

Align the Left and Right edges together. If the selected items are of different sizes, the smaller item will be
aligned spaced evenly between the left and right of the larger items.

Top-Bottom

Align the Top and Bottom edges together. If the selected items are of different sizes, the smaller item will be
aligned spaced evenly between the top and bottom of the larger item.

Place on Sheet
Left

Right

Top

Bottom

Centre

Centre Horizontally

Centre Vertically

Left

Aligns the selected item to the Left side of the page of the current paper size.

Right

Aligns the selected item to the Right side of the page of the current paper size.

Top

Aligns the selected item to the Top edge of the page of the current paper size.

Bottom

Aligns the selected item to the Bottom edge of the page of the current paper size.

Center

Aligns the selected item to the Centre of the page of the current paper size.

Center Horizontally

Aligns  the  selected  item to  the  horizontal  center  of  the  page  of  the  current  paper  size.  The  items  vertical
position in the page is not affected.

Center Vertically

Aligns  the  selected  item to  the  vertical  center  of  the  page  of  the  current  paper  size.  The  items  horizontal
position in the page is not affected.
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Order
In  3D  Architect  Home  Designer  you  can  stack  individual  elements  (objects,  text,  shapes  etc.)  or  grouped
components so that one appears in front of another. The order in which they appear in the stack in controlled
with the options in this menu.

Bring to Front

Bring Forward

Send to Back

Send Backward

Bring to Front

Moves the selected item or group to the front (top) of the stack.

Bring Forward

Moves the selected item or group forward (up) one place in the stack.

Send to Back

Moves the selected item or group to the back (bottom) of the stack.

Send Backward

Moves the selected item or group backwards (down) one place in the stack.

Extrude

The Extrude  function enables elements to be pushed and extended from the original  in order to create an
amendment to the original  shape. This enables irregular shaping of standard objects and can therefore be
used to show plinths, dwarf wall sections, buttressed areas etc.

Whilst  the Extrude  function  is  available  for  most  3D elements  within  the plan  (note:  it  cannot  be  used  on
catalogue  objects)  care  should  be  taken  on  more  complex  items  such  as  staircases,  where  the  extrusion
process  mould  be  time  consuming.  The  Extrude  function  can  also  be  applied  to  2D  shapes  created  from

using the 2D drawing tools  . Basic 3D objects can be created this way.

Convert Rooms into Individual Walls

When walls are created by using the Rooms tool, they are connected directly to all other walls formed from
the same room. To edit  the walls  individually  you need to use the Convert  Rooms into Individual  Walls
tool. This splits all of the rooms on the currently selected floor into separate walls. The room itself still exists
as an entity, but the walls can now be edited independently of each other.
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Properties

Displays the Properties dialogue box for the currently selected element e.g. below. The displayed properties
can be edited in the dialogue box as required.

Furnishing
Load Object

Load Object from 3D Warehouse

Texture Import Assistant
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Load Object
Load Object  opens a  standard  Windows  browser  dialogue  to  allow  you  to  locate  and  import  selected  3D
model  file  formats  in  to  your  3D  Architect  Home  Designer  project.  Once  imported,  models  can  be
manipulated, moved, edited and re-sized.

Load Object from 3D Warehouse
You  can  enhance  your  design  project  with  additional  furnishing  objects  by  connecting  to  3D  Warehouse
where  you  can  choose  from  thousands  of  free  downloadable  models  created  in  SketchUp.  An  internet
connection is required. Once you have found a model, you can insert this directly in to your project either in
2D Construction or 3D Furnishing mode. Once imported, models can be manipulated, moved, edited and re-
sized.

Please note: The link to 3D Warehouse will direct you to an external website beyond our control. Whilst we
try to ensure that all  links are appropriate for our audience, we cannot be held liable for the content of this
site. We also recommend that you read 3D Warehouse: Terms of Use.

Texture Import Assistant

The Texture Import Assistant provides a simple method to quickly add new texture files to your database
for use in decorating construction elements (floors, walls, roofs etc.). Using the assistant it is possible to add
saved images or take a scan direct from your connected scanner. The assistant steps through the process to
enable you to select a texture to import  and where it  should be placed in your database. At  this stage it  is
possible  to  add  new  folders  into  the  database  so  that  you  can  create  a  folder  structure  of  textures  in  a
meaningful way.

Step 1: Load / Scan Image
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Step 2: Name your new texture and create a target directory
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On completion of step 2, your texture will appear under the new directory in the Materials catalog 

View
Layout View

Show Page Border

Page Positioning

In-line Measurements

North Point

Cameras

Light Source

Grid

Sketch

2D View Texture Overlay
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Level of Detail

Timber Construction

Lighting

Shadows

Shadow Calculation

In-line Measurements (3D)

Transparent Building

Hide Facing Walls

Display Quality (3D)

Zoom

Layout View

Toggles the Layout View on and off. The layout view shows the edges of the page and the relative position
of your drawing enabling you to see how your drawings will print on your selected paper size.

Show Page Border
Toggles the page border on and off. The page border displays the outer margins of the printable area of the
selected paper size.

Page Positioning

Selecting Page Positioning adds a ghost outline of your page to your cursor; this can then be moved around
your drawing in order to re-locate the drawing elements in the page layout. Use Page Positioning to move
your page border around your drawing to achieve the layout you need.

Elevation Views...

Selecting the menu option 'Views > Elevation views...' will open up a basic viewer for displaying elevations
generated automatically from your floor plans. This viewer will display floors / layers currently have selected /
active in your project. For example if you only have the ground floor made visible in either 2D Construction or
3D Furnishing mode, then the viewer will only show an elevation view of ground floor. If you have all floors
visible, then the viewer will calculate elevation/side views showing all floors including roof.

Note: The elevation viewer allows you to display elevation views quickly and easily but is not used in
conjunction with Plan Mode where you can generate more detailed elevations and section views using the
plan elements available in the Tool Options Catalog. Plan Mode allows you to break apart individual
elevations and section views so we recommend working in this mode for making further edits to drawings.
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Hover your cursor over compass point and left click to select elevation view. The display will update. Other
options are also available in the icon bar for example print settings and display settings where you can create
your own title for each elevation or choose to switch off any horizontal or vertical edge dimensions.

Hover your cursor over compass point and left click to select elevation view. The display will update.

If you experience the following i.e. the display of elevation/side view is too small e.g. below then this is
because it is calculating size of landscape area too. You can switch off the Landscape layer through the
Layers Manager (menu Layers > Layer Manager)
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In-line Measurements

Toggles the display of the In-Line Measurements. The in-line measurements are the interactive dimension
indicators  which  display  in  either  2D  or  3D  views  for  the  selected  element.  Note  that  if  you  toggle  in-line
measurements on or off whilst you have an element selected, the display will remain until you de-select the
element.

North Point

A toggle option to show or hide the compass North Point. When displayed, the North Point can be dragged
to a new location. Left-clicking on the north point enables you to resize and rotate the direction of the pointer.

This toggle function can also be accessed by using the  icon on the bottom Status Bar.
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Cameras

Toggles the display of the location of any Cameras added to the project. The state of the toggle (on or off)
does not affect the view from the camera.

This toggle function can also be accessed by using the  icon on the bottom Status Bar.

Light Source

Toggles the display of the location of any Light Sources added to the project. The state of the toggle (on or
off) does not affect the output of the light source.

This toggle function can also be accessed by using the  icon on the bottom Status Bar.

Grid

Toggles the display of the drawing Grid on or off. The Grid is a snap target by default, toggling the view of
the grid off also removes it as a snap target.

This toggle function can also be accessed by using the  icon on the bottom Status Bar.

Sketch
As a Sketch

Settings

As a Sketch

Toggles the Sketch view on or off. The Sketch view enables a view which aims to replicate a hand-drawn
plan drawing style and affects the display of outlines and hatching patterns in the 2D view.

This toggle function can also be accessed by using the  icon in the bottom Status Bar.
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Settings

Define the Settings to be applied to the outline and hatching patterns when the sketch view is toggled on.

2D View Texture Overlay
Show

Saturation

Settings
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Show

Toggles the display of the textures used on the model on or off in the 2D view.  This toggle function can also

be accessed by using the  icon on the bottom Status Bar.

Saturation

Opens a slider to enable the Saturation of the 2D texture overlay to be altered. The lower the percentage,
the lighter the image will be. Conversely the higher the percentage, the more saturated the image becomes.

Settings

Change the display settings which are used when the background overlay toggle is turned on.

Timber Display (roofs)
Hide

Show

Exclusive

Hide

Hide the timber construction from view in both the 2D and 3D modes.

Show

Show the timber construction of appropriate elements. Timber construction will  be displayed in 2D and 3D
views.

Exclusive

Show only the timber construction of appropriate elements exclusively. Timber construction will be displayed
in 2D and 3D views.

The Exclusive  view for timber construction in walls  and floors can also be toggled by using the 
icons in the bottom Status Bar.

Note: If walls are not displaying in timber construction view then it's possible the walls in your project do not
currently have any timber construction detail applied to them. You can apply timber construction detail prior
to  placing  walls  or  after  placing  them  by  selecting  wall  and  clicking  the'  Timber  Construction'  tab  in  the
horizontal icon bar at top. In the dialogue box that appears, activate the box for 'With timber construction'
under 'General' tab.
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Lighting

The Lighting scenes in 3D Architect Home Designer will enhance your 3D scenes by utilizing the added light
source(s) to show detailed shadows and reflections from appropriate elements in the model. Using a lighting
scene will improve the look of your 3D views to enable you to produce better visualizations.

3D  Architect  Home  Designer  comes  with  a  set  of  pre-defined  lighting  scenes  to  cover  common  lighting
situations, however using the tools in the Lighting menu it is possible to add many more.

New Lighting Scene

Edit Current Scene

Copy and Edit Current Scene

New Lighting Scene

Create  a  New  Lighting  Scene  with  custom  properties.  Once  a  new  scene  has  been  created  it  will  be
available for selection from the main Lighting scene list.

Edit Current Scene

Opens the properties for the lighting scene currently in use to enable the settings to be edited and amended.

Copy and Edit Current Scene

Opens the properties for the lighting scene currently in use to enable the settings to be edited and amended
and creates a new entry in the Lighting scene list by creating a copy of the original scene.

Shadows

Toggle  the  display  of  Shadows  on  and  off  from  the  3D  model.  The  lighting  scene  used  to  calculate  the
shadows will be the last selected active lighting scene.

This toggle function can also be accessed by using the  icon in the bottom Status Bar.
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Shadow Calculation
Renders the current view to calculate the shadows based on the lighting scene currently  in  use.  Changing
the lighting scene will automatically result in a re-calculation of the shadows to the new settings.

In-line Measurements (3D)

Toggles the display of  the In-line Measurements exclusively  for  the 3D mode.  The in-line  measurements
are the interactive dimension indicators which display for the selected element. Note that if you toggle online
measurements on or off whilst you have an element selected, the display will remain until you de-select the
element.

Transparent Building
Renders the exterior surfaces of the building (walls and roof) in a semi-transparent material, allowing visibility
of the interior whilst still showing the walls and roof surfaces.

Hide Facing Walls
Dynamically hides exterior walls which face the viewer to enable complete visibility into the room or building.
Features inserted into the walls (such as doors and windows) are also hidden.

This toggle function can also be accessed by using the  icon in the bottom Status Bar.
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Display Quality (3D)

The options available under the Display Quality (3D)  menu directly affect the view of the model in the 3D
mode. Different view styles are available and some will increase the realism of the model whilst other views
may improve performance, particularly when navigating large and complex projects.

With Bump & Reflection Map

Standard Textures

Untextured

With Reflections

3D Textures

Colour Wireframe

Black Wireframe

Hidden Line Removal

Shaded with Edges & Textures

With Bump & Reflection Map

Toggles on any bump and/or reflection maps that are associated with the textures being used. Bump maps
are  used to  provide  a  feeling  of  depth,  increasing the 3D effect  of  a  texture.  Reflection  maps  are  used  to
show reflective surfaces of a texture.

Toggling off the bump & reflection map setting changes the display quality to Standard Textures.
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Roof tiles texture with bump & reflection mapping turned on.

Standard Textures

Shows the texture only, any associated bump or reflection maps are not used. The texture is displayed as a
flat image on the model.

Roof tiles texture with standard texture mode turned on.

Untextured

Selecting  Untextured  displays  the  model  with  no  textures  visible.  All  surfaces  will  be  present  but  will  be
displayed in white. The textures are not removed from the model using this view, just hidden until  the view
type is changed.

With Reflections

Select to turn on the display of any reflection properties of any of the textures/materials used in the project.
When selected the Display Quality must be set to With Bump & Reflection Map in order to see the effect.

This function can also be toggled on or off using the  icon on the bottom Status Bar.
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3D Textures

Select to turn on the display of any bump maps of any of the textures/materials used in the project.  When
selected the Display Quality must be set to With Bump & Reflection Map in order to see the effect.

There are three options for the display On, Off and Not During Movement. The third option of Not During
Movement  sets the 3D Textures  to  on,  but  temporarily  disables  them during onscreen movements of  the
model to enhance performance.

This function can also be toggled on or off using the  icon on the bottom Status Bar.

Colour Wireframe

This type of view shows only the outlines of the elements, as well as outlines of walls, windows, doors, etc.
The colours of these outlines correspond to the colours of the objects. For example, if you show a blue sofa
as a wireframe its outlines are blue lines.

Black Wireframe

This type of view shows only the outlines of the elements, as well as outlines of walls, windows, doors, etc.
All of the outlines are displayed in black.

Hidden Line Removal

This type of view shows only the outlines of the elements as well as the outlines of walls, windows and doors,
but unlike the wireframe view, the outlines are filled. The colour of the outlines is always black, and the areas
within outlines are always white

Shaded with Edges & Textures

This type of view shows only the outlines of the elements as well as the outlines of walls, windows and doors,
but unlike the wireframe view, the outlines are filled. The colour of the outlines is always black and the areas
within outlines are textured and shaded.

Zoom
Show All

Page Width

Full Page

Original Size

Zoom In (Enlarge)

Zoom Out (Reduce)

To Rectangle

To Selection

Percent

Show All

The view zooms to show the extent of all elements drawn in the project. This tool can be used to zoom in or
out depending on your current view point. It will always zoom to the whole project filling the current window
and is usable in both 2D and 3D.

This function can also be accessed by using the Show All  icon on the Tool Options Header Bar.
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Page Width

Alters the view to ensure that the full width of the current page is displayed in the viewable area. Functions in
2D view only.

Full Page

Alters the view to ensure that the full extent of the current page is displayed in the viewable area. Functions
in 2D view only.

Original Size

The view is reset to the default zoom level, returning the project view to its Original Size.  Functions in 2D
view only.

Zoom In (Enlarge)

Changes your standard cursor to an enlarging magnifying glass. Left-click to zoom in by a factor of two (i.e.
doubling the zoom level).

Zoom Out (Reduce)

Changes your standard cursor to a reducing magnifying glass. Left-click to zoom out by a factor of two (i.e.
halving the zoom level).

To Rectangle

Zoom to an area defined by using a standard selection rectangle.

To create the selection rectangle, with your cursor left click at the point of the first corner (for example at the
top left) and then with the left mouse button held down, drag your cursor to the opposite diagonal corner (so
bottom right  in  this  example).  Release your  mouse button and the area selected  will  be  the zoomed area.
The smaller the selection rectangle, the greater the zoom effect.

This  function  can  also  be  accessed  by  using  the  Zoom  to  Rectangle  icon   on  the  Tool  Options
Header Bar.

To Selection

Zooming To Selection uses the magnifying cursor icon. When you then click on an element in the project
the view is zoomed so that the selected element is maximized in the view. For example, clicking on a window
will zoom into that window so that it fills as much of the viewable area (2D or 3D) as possible. Therefore the
amount of zoom will depend upon the size of the element selected.         

Percent

Zooms the view to a set percentage of the original size. Select from either 50%, 75%, 100%, 200%, 400% or
define your own. Selecting 100% will revert to the original size.

Project
Project Properties

North Point

Geographical Position
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Background

Shadows

Reflections

Project Properties

The Project Properties is normally used at the start of a project to define the setting for the drawing (paper
size  and  format,  scale,  measurement  units)  and  many  of  these  settings  will  be  applied  by  the  project
assistant if this option is active. However these settings are completely dynamic and can be changed at any
time to suit specific requirements.

North Point

Sets the angle and size of the North Point when displayed on the plan. Whilst the North Point is traditionally
included  in  plan  drawings  to  indicate  direction,  it  is  also  used  in  3D  Architect  Home  Designer  when
calculating shadows using the sun as a light source.
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Geographical Position
Geographical Position can be set to the correct latitude and longitude for the location of the building. This
value can be entered manually or selected through Google® Maps.
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Background

Opens  the  Background  dialogue  box  where  you  can  change  the  background  colour  or  image  for  the  3D
model.  Through the Type  drop  down list,  this  can  be from a  selection  of  colour  and  wrap  styles  including
gradients and solid colours or use an image (for example a photograph taken from the site or your build).

Example: Background picture

 

Example: Two colour gradient...
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Shadows

Set  the  calculation  options  to  be  used  in  the  project  when  Shadows  are  calculated.  The  dialogue  box
features drop downs with simple options to affect the display of shadows on the project.

Reflections

Set  the  calculation  options  to  be  used  in  the  project  when  Reflections  are  calculated.  The  dialogue  box
features drop downs with simple options to affect the display of reflections in the project.

Floors
Edit Active Floor

New Upper Floor

New Floor Above Current

New Lower Floor

Create Variant of Current Floor

Delete Active Floor

Delete Selected Floors

Only Active Floor is Visible

All Floors Visible

Active & Selected Floors Visible
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Edit Active Floor
Edit  Active  Floor  opens  a  dialogue  box  for  the  properties  of  the  currently  selected  active  floor.  With  the
options available in the dialogue box, the properties of the floor can be changed as required. The floor height
settings can be amended together with information labels and floor/ceiling materials.

New Upper Floor
Creates  a  new  floor  at  the  top  of  the  building.  When  creating  a  new  floor  there  are  a  series  of  options
enabling you to copy all, some or none of the currently selected floor to use as a template for the new floor.

New Floor Above Current
Creates a new floor directly above the currently active floor. If there are already floors above the current floor,
they will be pushed up a level to accommodate the new floor. When creating a new floor there are a series of
options enabling you to copy all, some or none of the currently selected floor to use as a template for the new
floor.

New Lower Floor
Creates a new floor at the bottom of the building.  When creating a new floor  there are a series of  options
enabling you to copy all, some or none of the currently selected floor to use as a template for the new floor.

Create Variant of Current Floor
Creates a copy of the currently active floor in the same location. This enables multiple variants of the same
floor to be placed in the same plan and model so that alternate layouts etc can be experimented with, without
affecting the rest of the building. You can then switch between the variants.

When creating a variant of the current floor there are a series of options enabling you to copy all,  some or
none of the currently selected floor to use as a template for the new variant.

Delete Active Floor
Deletes the currently active floor from the project. Please be aware that it is not possible to ‘undelete’ a floor,
however the Undo function can reverse an accidental delete provided you haven’t closed the editing session.

Delete Selected Floors
Shows a list of the floors enabling one or more floors to be deleted. Please be aware that it is not possible to
‘undelete’ a floor, however the Undo function can reverse an accidental delete provided you haven’t closed
the editing session.

Only Active Floor is Visible
Only the currently active floor is visible in the viewing area for both 2D and 3D display modes.

All Floors Visible
All floors within the plan are visible in the viewing area for both the 2D and 3D display modes.
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Active & Selected Floors Visible
Displays the currently active floor together with any other floors marked as visible.

Layers
Manage Layers

Add New Layer

Delete Active Layer

Delete Layers

Only Active Layer is Visible

All Layers Visible

Active & Selected Layers Visible

Manage Layers
3D Architect Home Designer utilises a system of  layers where different  elements of  a drawing are placed.
This use of layers creates maximum flexibility, allowing components of elements and structures to be hidden,
amended or deleted as required.

The  Manage  Layers  option  displays  the  layer  management  dialogue  box.  From  here  you  can  see  which
layers  the  plan  is  composed  of  and  then  add  or  delete  new  layers  and  change  the  protection  level  and
visibility of the layers.

Add New Layer
Many  elements  of  the  construction  will  automatically  generate  their  own  layer  (roofs,  doors  &  windows,
guideline etc.). However it is also possible to manually add a new layer. This layer can then be used to hold
drawing elements which may need to be separate to the standard layers.

An example of this may be to create a layer for your plumbing and another for your electrics. These layers
can  then  hold  information  such  as  symbols  and  2D  line  information  to  show  the  appropriate  plumbing  or
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wiring runs and fittings.  The benefit  of  using layers in  this  way is  that  they can then be toggled on and off
from the layer display to hide or show these overlays.

Delete Active Layer
Deletes the currently active layer and all of the information contained within it. Please be aware that it is not
possible  to  ‘undelete’  a  layer,  however  the  Undo  function  can  reverse  an  accidental  delete  provided  you
haven’t closed the editing session.

Delete Layers
Shows  a  list  of  the  layers  enabling  one  or  more  layers  to  be  deleted,  removing  all  of  the  information
contained within it.  Please be aware that it  is not possible to ‘undelete’ a layer, however the Undo  function
can reverse an accidental delete provided you haven’t closed the editing session.

Only Active Layer is Visible
Displays only the contents of the layer that is currently active. All other layers will be hidden from view.

All Layers Visible
Displays the contents of all layers in the project.

Active & Selected Layers Visible

Displays the currently  active layer  together  with  any  other  layers  marked  as  visible  in  the Manage Layers
dialogue.

Options
Program

Numeric/Step Input

Display

In-line Measurements

Sketch

Object Info

Snap

Grid

Snap (3D)

Navigation (3D)

Inserting & Moving

Save

Print

Display Quality (3D)

Database

Delete User Database

Use Project Assistant

Use Plan Mode Assistant
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Program

General Program settings can be changed here which include how 3D Architect Home Designer behaves at
start-up and importing other elements into a project.

Numeric/Step Input
Sets the options for the use of the mouse when the numeric input method is being used. Also sets the option
for  the  general  direction  of  drawing  (this  impacts  on  how  some  other  tools  behave  once  walls  have  been
drawn).
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Dimensions

See also:

Linear dimension
Linear dimension (specify distance)
Horizontal dimension (specify distance)
Vertical dimension (specify distance)
Chain dimensions (specify distances)
Multiple dimensions
Diameter dimension
Radial dimension
Arc length dimension
Linear dimension (arrow)
Diameter dimension (arrow)
Radial dimension (arrow)
Angle dimension

Display (3D)
Sets the brightness, saturation and anti-aliasing (smoothness) levels for the 3D display. This option is greyed
out in 2D mode.

Note: Changes to the anti-aliasing setting will require a restart of 3D Architect Home Designer. 
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In-line Measurements

Set the options for both the ln-line Measurements and Dimensions tools using this menu. This enables you
to select when and on what to use the In-line Measurement system and how to display any measurements
added using the Dimension tools.
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Elevation Views

Selecting the menu option 'Views > Elevation views...' will open up a basic viewer for displaying elevations
generated automatically from your floor plans. This viewer will display floors / layers currently have selected /
active in your project. For example if you only have the ground floor made visible in either 2D Construction or
3D Furnishing mode, then the viewer will only show an elevation view of ground floor. If you have all floors
visible, then the viewer will calculate elevation/side views showing all floors including roof.

Note: The elevation viewer allows you to display elevation views quickly and easily but is not used in
conjunction with Plan Mode where you can generate more detailed elevations and section views using the
plan elements available in the Tool Options Catalog. Plan Mode allows you to break apart individual
elevations and section views so we recommend working in this mode for making further edits to drawings.
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Click inside window to show first view. Viewpoint can be changed using the compass icon in top icon bar.

Hover your cursor over compass point and left click to select elevation view. The display will update. Other
options are also available in the icon bar for example print settings and display settings where you can create
your own title for each elevation or choose to switch off any horizontal or vertical edge dimensions.

If you experience the following i.e. the display of elevation/side view is too small e.g. below then this is
because it is calculating size of landscape area too. You can switch off the Landscape layer through the
Layers Manager (menu Layers > Layer Manager)
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Sketch

Select the settings to be used when the Sketch view is active.
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Object Info

Sets  the  quality  and  background  options  for  previewing  an  object  from  the  Object  Catalogue  by  double-
clicking it to view in the o2c preview player.

Snap

The Snap settings affect the objects to which and the distance from which, your cursor is pulled to ensure it
connects  correctly  to  other  elements.  The  Snap  settings  enable  you  to  control  which  parts  of  objects  are
used as snap targets and the strength of the snap.
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Grid

Sets the sizing, display and snap functions of the Grid feature.

Snap (3D)

The Snap settings affect the objects to which and the distance from which, your cursor is pulled to ensure it
connects  correctly  to  other  elements.  The  Snap  settings  enable  you  to  control  which  parts  of  objects  are
used as snap targets and the strength of the snap.

Note that this option only affects the behaviour of Snap in relation to the objects and furniture in 3D mode.
Also be aware that  the snap functions work in  reference to the bounding box of  the object  rather  than the
corners/edges of the object itself.
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Navigation (3D)
Set the view angle, head height and additional options when navigating and walking through your project in
the 3D view.
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Inserting & Moving (3D)

Determine how objects behave when they are inserted from the Object Catalogue.

Save

Setting the Save options enables you to select if and how often to create back-ups and auto-recovery files,
whether to prompt for file saving on closing a project and how many back-up copies to keep.
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Import
Import settings for project files and DWG/DXF file format.

Export (DXF/DWG)
Export settings for DWG/DXF file format.

Intersect Roofs

Merging multiple roof structures

Complex roof structures are handled with ease in 3D Architect Home Designer. The flexibility of use of the
freeform roof type and placement methods including by individual polygon points means that demanding
designs can be catered for very straightforwardly.
However with very complex creations, often arising from extending or radically remodeling an existing
property, it is also possible to create the roof using multiple roof structures which can then be blended
together as a single entity.

1. Using the standard roof tools, draw your roof configuration, making use of more than one roof
style/type/design. For the best results make sure that the roofs overlap (Tip: you want to make sure that
the ridge line is at the correct setting to be already in the final location)

2. The roof sides/edges etc will cut through each other where they currently cross.
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3. Now simply navigate to the menu Options > Intersect Roofs to toggle the automatic intersection on.

4. As you can see from the screenshot below, when we show the timber construction, the structure of the
roof has been automatically amended as the point of intersection.
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5. You can navigate to Options > Intersect Roofs and toggle the join off if required. 

Print
Set  the output  paper  size  and  orientation  together  with  advanced settings  for  selecting  specific  layers  and
printing over multiple sheets for smaller paper sizes.

Database
Show the location of databases currently in use by 3D Architect Home Designer and add a new database or
delete an existing database.

Note: We would not normally recommend you add or delete any databases unless you are familiar with the
use of databases in 3D Architect Home Designer.
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Delete User Database
Deletes  all  of  the  contents  of  the  existing  user  database.  Once  completed  the  next  time  you  launch  3D
Architect Home Designer a new blank user database will be created.

Note: We would not normally recommend you delete any databases unless you are familiar with the use of
databases in 3D Architect Home Designer.

Use Project Assistant

In 3D Architect Home Designer the Project Assistant launches by default to prompt you through the setup
of a new project. Project Assistant ensures you define your paper size and format, scale and measurement
units  at  the  outset.  Leaving  this  option  selected  will  launch  Project  Assistant  each  time  you  start  a  new
project. If you wish to skip the project assistant, un-tick this option.

Use Plan Mode Assistant

The  Plan  Mode  Assistant,  when  selected,  launches  when  you  enter  Plan  Mode.  Plan  mode  is  used  to
produces layouts containing multiple views of the project and enables you to display floor plans,  elevations
and models on the same sheet. Plan Mode Assistant is used to set-up the basic output settings for the plan
mode  such  as  paper  size,  drawing  scale  and  title  block  information.  If  you  wish  to  skip  the  plan  mode
assistant when using plan mode, un-tick this option.

Display
Catalogue

Numeric Input

Toolbar

Construction Tools

Status Bar
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Catalogue

Toggles  on  or  off  the  display  of  the  Tool  Options  Catalogue/Object  Catalogue  area  on  the  right  of  the
screen.

Numeric Input

Toggles on or off the display of the Numeric Input area on the bottom of the screen.

Toolbar

Toggles on or off the display of the Top Horizontal Icon Bar and Tool Options Header Bar display area.

Construction Tools

Toggles on or off the display of the Tool Menu Bar on the left-hand side of the screen.

Status Bar

Toggles on or off the display of the Status Bar at the bottom of the screen.

Window

Contains the standard Windows options that you will find in most software packages to enable you to arrange
multiple windows views.
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Construction Mode Tool Menu Bar
Construction Mode  is  used to  create  the structure  and  layout  of  the  building.  Working  in  a  2D  top-down
view, the tools in Construction Mode are the primary elements required to create a building.

Selection Tool
Editing Tools
Modify Walls
Walls
Rooms
Doors
Windows & Cut-outs
Stairs
Ceilings & Cut-Outs
Balcony, Veranda, Platform, Terrace
Supports & Chimneys
Roofs
Dormers
Skylights
Objects
Material
Material Area
Terrain/Height Points
Path, Plot, Area, Pond
Dimensions
Text
2D Drawing Tools
Guidelines
Symbols
Heating, Electrics & Sanitary

Selection Tool

See also

Basic Mouse & Keyboard Controls
2D Construction Mode
3D Furnishing Mode

The standard  Selection  tool  is  accessed  from the Tool  Menu Bar  on  the left  hand  side of  the screen  by

clicking the Selection icon .

This is the normal default cursor that would be used when no other tool  is currently selected. To select an
element already entered within the project, using the Selection tool, left click on the element. The selected
element can then be amended and edited as required.

Using the same tool it is also possible to select multiple elements at the same time. There are two options to
selecting multiple elements: Firstly, holding down either the Shift or CTRL key whilst left-clicking your mouse
will enable you to select more than one element as a time. The other option is to use a ‘selection area’.

To create a selection area simply left-click your mouse on the page (not a drawing element) and hold down
the mouse button. Now drag the mouse to the opposite diagonal corner, ensuring that  the virtual rectangle
that  you  create  encompasses the object(s)  you  wish  to  select.  Once  you  have  everything  inside  the  area,
release the left mouse button and everything within the chosen area will be selected.

Note: This same selection tool can also be used for zooming by selecting this in the Tool Options circled

below.



Construction Mode Tool Menu Bar

100

See also

2D Construction Mode

3D Furnishing Mode

Editing Tools
Wall length
Miter walls (L)
Join walls (T)
Wall break

A  selection  of  2D  and  3D  editing  tools  for  modifying  walls,  lines,  2D  shapes,  textures/materials,  copying,

moving,  rotating,  hatching,  etc.Click  on the Editing Tools  icon  on the Tool  Menu Bar.  All  available
tools can be accessed from Tool Options Catalog. These tools are also available through the menu Edit >
Tools.

Depending on what mode you are in (2D Construction, 3D Furnishing, Plan mode) the items in the catalog
will be different as follows. Note that in Plan mode there are two tabs available in the Tool Options catalog.
The first tab contains the same editing tools as in 2D Construction mode and the second tab contains Plan
elements for laying out your plan set e.g. elevation/section views.

2D Construction Mode Editing Tools
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3D Furnishing Mode Editing Tools
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Plan Mode Editing Tools (2 tabs available)
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The editing tools also appear in the fly-out menu area when you hover your mouse cursor over icon. The
tools available  here are a selection of  the last  used editing tools,  allowing  easy access to  commonly  used
tools.

Modify Walls

 

The wall modification tools enable you to edit existing walls in your project.

Wall length

Miter walls (L)

Join walls (T)

Wall break
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Wall length

The Wall Length tool  can be used to increase or decrease the length of an existing wall in a
project drawing.

This same function is also accessible in the menu Edit > Tools > Modify Walls > Length

Reduce length of wall using the Wall length tool

From the left tool menu bar click the Editing Tools icon 

1. In the Tool Options Catalog, open the  folder and left-click the  tool.

2. Hover the cursor over the wall where it should highlight green.

3. To reduce the length of a wall, left click on the edge of the wall (e.g. arrow 1) then left-click on the part of
the wall you’d like it to be reduced to (e.g. arrow 2). 

 

Note: Click the Esc key on your keyboard to de-select everything before continuing.

Increase length of wall using the Wall length tool
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From the left tool menu bar click the Editing Tools icon 

1. In the Tool Options Catalog, open the  folder and left-click the  tool.

2. Hover the cursor over the wall where it should highlight green.

3. To increase the wall  length;  left-click  the edge of  wall  (arrow 1)  where it  ends and drag the wall  to  your
desired position (arrow 2). For precise wall lengthening, once you have left-clicked on the edge of the wall,
drag the wall  in the direction you’d like to extend it  then before left-clicking to secure the wall’s  position,
use your keyboard and type in desired length. Press the Enter  key or click the Apply  button in  numeric
input bar.

Miter walls (L)

The Miter Walls tool  is used to miter together two adjacent walls at a corner. Generally, walls
will be automatically connected and mitered when using the wall tools to create a room area.

This same function is also accessible in the menu Edit > Tools > Modify Walls > L-Trim

1. From the left tool menu bar click the Editing Tools icon 
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2. In the Tool Options Catalog, open the  folder and left-click the  tool.

3. In your drawing, left-click on one wall and then left-click on the other wall to join the walls without any
overlapping. 

In the walls section see also

Trimming walls together

Join walls (T)

The Join Walls  tool   is used to miter  together  two adjacent  walls  where a wall  end meets a
long  wall  edge.  Generally,  walls  will  be  automatically  connected  and  mitered  when  using  the  wall  tools  to
create a room area.

This same function is also accessible in the menu Edit > Tools > Modify Walls > T-Trim

1. From the left tool menu bar click the Editing Tools icon 

2. In the Tool Options Catalog, open the  folder and left-click the  tool.

3. In your drawing, left-click on the wall that you’d like to join to another wall, then simply left-click on the wall
you’d like it to be joined to. 
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Wall break

The Wall Break tool  can be used to split an existing wall on a project drawing into two separate
walls.

This same function is also accessible in the menu Edit > Tools > Modify Walls > Break

1. From the left tool menu bar click the Editing Tools icon 

2. In the Tool Options Catalog, open the  folder and left-click the  tool.

3. Diagram 1: To make a break in a wall in order to create two separate walls that are still joined together,
you must left-click once on the wall you’d like to break and then left-click once on the exact section of the
wall you’d like the break to be.

4. Diagram 2: Now the break has been made, if you click on the right hand side of the wall, you’ll be able to
see the new separate wall segment highlighted.

5. Diagram 3: By left-clicking the left side of the wall, it will show you the other wall segment.
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Walls
See also:

Drawing single walls
Drawing continuous walls
Drawing single walls to exact length
Drawing continuous walls to exact length
Drawing walls to guidelines
Drawing single walls at fixed angle
Drawing single wall at a right angle
Rounding off wall corners
Drawing garden wall
Using virtual walls
Stretching a section of building using mouse
Stretching a section of building using numeric input
Transferring properties from one wall to another
Trimming walls together
Drawing upper and lower beams using parallel input tool
Changing length of wall using in-line measurements
Changing length of wall through the size and position dialog box
Adjusting the height of individual walls 
Updating existing wall to a different construction type
Modifying wall properties - creating new construction layers 

The Wall option tool  is used to create the shape of your rooms, floors and buildings. Selecting the Wall

 tool  from the Tool Menu Bar displays the wall placement options in the Tool Placement Context Bar
together with the pre-set wall types currently in the database, which can be chosen from the Tool Options
Catalogue.
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In  the  catalog,  those  icons  identified  with  a  small  yellow  windows  folder  symbol  can  be  accessed  by  left-
clicking to reveal  the subset  of  options.  Depending on what tool  you  are  accessing,  there  could  be further

sub-folders  to click.  With the following icon  you can move up one folder  in  the directory  structure.  By

clicking the  icon you always move first into the folder that was last opened and by clicking the icon next

to it  returns you back to top of directory.
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Hovering your  mouse over  the Walls  icon will  also display recently  used wall  types which can be selected
directly from the fly-out menu.

Wall  properties  are  fully  customizable  using  the  options  in  the  Tool  Options  Header  Bar.  These  options
enable you to set wall materials, 2D display details, hatching patterns etc. Of course, you can modify a wall
before inserting it  in to your drawing but walls that have already been inserted can also be modified at any
stage in your project. Just select a wall element by left-clicking it  (see Selection Tool)  (ensure you are on
correct  floor  and  the element  is  not  protected/locked from further  editing)  and  use  the options  in  the Tool
Options Header Bar. Because the wall has already been inserted in to your drawing, on selection, additional
options may become available in the Tool Options Header Bar e.g.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
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opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.

Placing walls  accurately can be achieved easily  in  many methods including using grids,  guides and rulers,
numeric input options and selecting the appropriate wall axis for drawing.

Drawing single walls

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog on right of screen, left-click on the Walls folder  to open a selection
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of wall types.

3. Select a wall type and select the placement option Single wall. 

4. Left-click on the work sheet to set the start point of wall. Move your mouse and the wall will follow the
direction of the cursor together with its length. Do not second left-click.

Note: Hold down the Shift key at same time of drawing wall to ensure that it snaps to a vertical or horizontal
position on sheet. Before placing wall in position, use the key combination Ctrl + W to toggle between the
wall edges and wall axis. This lets you define which wall edge you wish to place e.g. the inside edge of wall,
center line of wall or outside edge of wall. Try pressing this key combination a few times to see the effect on
screen.

5. When you have reached correct wall length, left-click to set the end point of wall.

6. Repeat these steps to continue drawing vertical and horizontal walls. With snap on by default, the wall will
attach itself to existing wall. The wall corners will form automatically.

a) 

b) 
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c) 

Note: You can cancel the single wall function at anytime with the Esc key or by right-clicking and selecting
Cancel Function.

Note: When the final wall connects back to the start point, the room is automatically labelled with a room
number. This is an important part of the checking process when drawing in walls. The room label confirms
that all of your walls connect, with no gaps or spaces, to form a fully contained room e.g.

 = 
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Drawing continuous walls

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog on right of screen, left-click on the Walls folder  to open a selection
of wall types.

3. Select a wall type and select the placement option Polygonal walls.

4. Click the Tool options icon in the top tool options header bar.  

5. In the dialog box that appears you can determine how the walls are entered. For example, by selecting the
option Do not group, walls drawn continuously will be entered as single walls rather than grouped walls
allowing you to edit them individually at a later stage.

Note: Walls that have been grouped together can also be ungrouped after they have been drawn by clicking
on a wall and then clicking the green ungroup symbol attached to wall group. You can also ungroup walls
through the Edit menu.

6. Close the Tool options dialog box

7. Left-click on the work sheet to set the start point of wall. Move your mouse and the wall will follow the
direction of the cursor together with length. Do not second left-click.

Note: Hold down the Shift key at same time of drawing wall to ensure that it snaps to a vertical or horizontal
position on sheet. Before placing wall in position, use the key combination Ctrl + W to toggle between the
wall edges and wall axis. This lets you define which wall edge you wish to place e.g. the inside edge of wall,
center line of wall or outside edge of wall. Try pressing this key combination a few times to see the effect on
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screen.

8. When you have reached correct wall length, left-click to set the end point of wall.

9. The start point of next wall will then attach itself to end point of last wall drawn.

10.Next, move your mouse and the wall will follow the direction of the cursor again together with length.
When you have reached the correct length of second wall, left-click to set the end point of second wall. 

The wall corners will form automatically.

11.Repeat these steps to continue drawing vertical and horizontal walls in this way. 

12.Complete drawing continuous walls by pressing the Esc key or by right-clicking and selecting Complete
element (up to last wall drawn) in the context menu that appears. In same menu, the option for Close
element will automatically draw a wall from end point of last wall drawn to the start point of first wall
drawn. 

Note: You can cancel the polygonal wall function at anytime by right-clicking and selecting the Cancel
Function in the context menu that appears.

Note: When the final wall connects back to the start point, the room is automatically labeled with a room
number. This is an important part of the checking process when drawing in walls. The room label confirms
that all of your walls connect, with no gaps or spaces, to form a fully contained room e.g..
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Drawing single walls to exact length

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls  catalog on right of screen, left-click on the Walls folder  to open a selection
of wall types.

3. Select a wall type and select the placement option Single wall 

4. Left-click on the work sheet to set the start point of wall. Do not second left-click.
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Note: Before placing wall in position, use the key combination Ctrl + W to toggle between the wall edges and
wall axis. This lets you define which wall edge you wish to place e.g. the inside edge of wall, center line of
wall or outside edge of wall. Try pressing this key combination a few times to see the effect on screen.

5. Using your keyboard type in desired length of wall. The Distance field in the numeric input bar at bottom
of screen will highlight.

6. Next press the Tab key. The Angle field in the numeric input bar at bottom of screen will highlight.

7. Using your keyboard type in desired angle of wall. Press the Enter key or click the Apply button in
numeric input bar. Your first wall will be placed in position at the length and angle specified.

8. Repeat these steps to continue drawing vertical and horizontal walls in this way. With snap on by default
the wall will attach itself to existing wall. The corners of walls will form automatically.

Note: You can cancel the single wall function at anytime with the Esc key or by right-clicking and selecting
Cancel Function.

Note: When the final wall connects back to the start point, the room is automatically labelled with a room
number. This is an important part of the checking process when drawing in walls. The room label confirms
that all of your walls connect, with no gaps or spaces, to form a fully contained room e.g.

 = 
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Drawing continuous walls to exact length

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog on right of screen, left-click on the Walls folder  to open a selection
of wall types.

3. Select a wall type and select the placement option Polygonal walls 

4. Click the Tool options icon in the top tool options header bar.  

5. In the dialog box that appears you can determine how the walls are entered. For example, by selecting the
option Do not group, walls drawn continuously will be entered as single walls rather than grouped walls
allowing you to edit them individually at a later stage.
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Note: Walls that have been grouped together can also be ungrouped after they have been drawn by clicking
on a wall and then clicking the green ungroup symbol attached to wall group. You can also ungroup walls
through the Edit menu.

6. Close the Tool options dialog box

7. Left-click on the work sheet to set the start point of wall. Do not second left-click.

Note: Before placing wall in position, use the key combination Ctrl + W to toggle between the wall edges and
wall axis. This lets you define which wall edge you wish to place e.g. the inside edge of wall, center line of
wall or outside edge of wall. Try pressing this key combination a few times to see the effect on screen.

8. Using your keyboard type the desired length of wall. The Distance field in the numeric input bar at bottom
of screen will highlight.

9. Next press the Tab key. The Angle field in the numeric input bar at bottom of screen will highlight.

10.Using your keyboard type the desired angle of wall. Press the Enter key or click the Apply button in
numeric input bar. Your first wall will be drawn at the length and angle specified.

11.The start point of next wall will then attach itself to end point of last wall drawn..

12.Type desired length of second wall. The Distance field in the numeric input bar at bottom of screen will
highlight again.

13.Next press the Tab key. The Angle field in the numeric input bar at bottom of screen will highlight again.

14.Type the desired angle of second wall. Press the Return key or click the Apply button in numeric input
bar. Your second wall will be drawn at the length and angle specified.
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The wall corners will form automatically.

15.Repeat these steps to continue drawing vertical and horizontal walls in this way.

16.Complete drawing continuous walls by pressing the Esc key or by right-clicking and selecting Complete
element (up to last wall drawn) in the context menu that appears. In same menu, the option for Close
element will automatically draw a wall from end point of last wall drawn to the start point of first wall
drawn. 

Note: You can cancel the polygonal wall function at anytime by right-clicking and selecting the Cancel
Function in the context menu that appears.

Note: When the final wall connects back to the start point, the room is automatically labeled with a room
number. This is an important part of the checking process when drawing in walls. The room label confirms
that all of your walls connect, with no gaps or spaces, to form a fully contained room e.g..

 = 
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Drawing walls to guidelines
An easy and accurate method is to use guidelines to plan out your building, even before placing the first wall.
These can be used also for pegging out your plot or for accurately inserting other elements in to your plan.

There are a number of guideline options but one of most useful ones is Parallel to reference line
(guideline) for spacing your guidelines at exact distances. Practice using this somewhere in your plan by
following the example steps below:

1. Select the Guideline tool from the icon bar 

2. From the Guidelines catalogue left-click the icon for Arbitrary line (guideline) 

3. Left-click on your work sheet followed by a second left-click to place vertical guideline in position. Before
the second left-click, hold down the Shift key at same time of drawing guide to ensure it snaps to a vertical
or horizontal position on sheet.
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4. In the Guidelines catalogue select the guideline option Parallel to reference line (guideline)  

5. With this selected, click on the reference guideline you just placed (cursor will snap to the reference line)
to display the following Tool options dialog box.

6. Here you can enter the offset distance e.g. 5 ft

7. Move the mouse cursor either side of reference guideline where you want the guideline placed (highlighted
green) and then left-click to place guideline in position.
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8. You will now have two guidelines in place with an exact distance of e.g. 5 ft between them. With these in
place you can accurately draw in a wall for example by using one guideline as start point of wall and then
the other as end point of e.g. below.

Note: If the reference line/element does not highlight red then it's possible you will have to make some
changes in the Snap dialog box (menu item Options > Snap). There are a number of settings in the Snap
dialog box but the most common cause for snap not working in 2D is if the 'Snap only in current layer' box
is enabled.
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Drawing single walls at fixed angle

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog to right of screen, left-click the Walls folder  to open a selection of
wall types.

3. Select a wall type and left-click the placement option for Angled Wall 

4. Click the Tool options icon in the top tool options header bar 

5. In the dialog box that appears enter the reference angle of wall.

6. Move your cursor over reference wall and left click. Your wall will be created at the selected angle to this
wall e.g. below.

7. Move your cursor to desired position and click to specify the starting point of wall e.g. below.
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8. Having specified start point, the wall will attach itself to guideline together with dimensions. By moving your
cursor, the length of wall will change.

Note: Before placing the wall in position, use the key combination Ctrl + W to toggle between the wall edges
and wall axis. This lets you define which wall edge you wish to place e.g. the inside edge of wall, center line
of wall or outside edge of wall.

9. Finally, when you have determined wall length, left-click to set the end point of wall.

Note: You can draw walls to exact length using numeric input. See Drawing single walls to exact length

Drawing single wall at a right angle

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog to right of screen, left-click the Walls folder  to open a selection of
wall types.
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3. Select a wall type and select the placement option Wall at Right Angle 

4. Move your cursor over reference wall (the cursor will snap to reference wall) and left-click. Your wall will be
created at a right angle to this wall e.g. below.

5. Move your cursor to desired position and left-click to specify the starting point of wall e.g. below.
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6. Having specified start point, the wall will attach itself to guideline together with dimensions. By moving your
cursor, the length of wall will change.

Note: Before placing the wall in position, use the key combination Ctrl + W to toggle between the wall edges
and wall axis. This lets you define which wall edge you wish to place e.g. the inside edge of wall, center line
of wall or outside edge of wall.
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7. Finally, when you have determined wall length, left-click to set the end point of wall.

Note: You can draw walls to exact length using numeric input. See Drawing single walls to exact length
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Rounding off wall corners

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog to right of screen, left-click the Round Off Walls icon 

3. Click the Tool options icon in the top tool options header bar 

4. In the dialog box that appears you can determine maximum length of straight wall segment in curved wall.

5. Move the mouse cursor over to the wall to round off. The active wall will highlight in green e.g. below.

6. Left-click on this wall and then move your cursor over to the second wall to round off e.g. below. This wall
will highlight green too.
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7. On selection, left-click on second wall.

8. In this final step, move your cursor to determine position of curve and left click to place curve in position
e.g. below.
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Note: If you are applying this to walls that have been drawn using polygonal input, ensure that the walls are
not grouped otherwise you will not be able to select/edit walls individually. Walls that have been grouped
together can be ungrouped after they have been drawn by clicking on a wall and then clicking the green
ungroup symbol attached to wall group. You can also ungroup walls through the Edit menu.

Drawing garden wall

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog to right of screen, left-click the Garden Walls folder  to open a
selection of wall types.

3. Select a garden wall type and select the placement option Single wall 

4. In the Tool Options Header bar click the tab for Garden Wall to open up following.

5. In the dialog box that appears you can specify its thickness, height and distance from ground in the Lower
Level input field before drawing wall in position. You can access this dialog box and modify the properties
of garden wall later on by clicking a wall segment in your plan followed by the same Garden Wall tab in
Tool Options Header bar.
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6. Confirm settings by closing dialog box.

7. Move your cursor over to work sheet and left-click to set the starting point of garden wall. Move your
mouse and the wall will follow the direction of the cursor together with length.

Note: Hold down the Shift key at same time of drawing wall to ensure that it snaps to a vertical or horizontal
position on sheet. Before placing wall in position, use the key combination Ctrl + W to toggle between the
wall edges and wall axis. This lets you define which wall edge you wish to place e.g. the inside edge of wall,
center line of wall or outside edge of wall. Try pressing this key combination a few times to see the effect on
screen.

8. When you have reached correct wall length, left-click to set the end point of wall.

9. Repeat these steps to continue drawing vertical and horizontal walls. With snap on by default the wall will
attach itself to existing wall. The corners of walls will also form automatically.

Note: You can cancel the single wall function at anytime with the Esc key or by right-clicking and selecting
Cancel Function.

Note: You draw garden walls in the same way as normal walls as described in previous topics. Please refer
to these on how to draw continuous walls using the polygonal placement option and drawing walls to exact
length for example. See Walls

Using virtual walls
3D Architect Home Designer automatically detects whether an area is completely enclosed by walls, and if
so, defines this area as a room. It is necessary under certain circumstances to define rooms that are not
completely enclosed by walls. With things like balconies, for example, 3D Architect Home Designer helps you
create special rooms which otherwise are not completely enclosed by walls – it does this through the use of
virtual walls. The principle is simple. You place a virtual wall like a normal wall. The difference is that in 3D
Design mode you won’t see the virtual wall at all. 

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog to right of screen, click the Virtual Wall icon 
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Note: The same placement options are available as normal walls e.g. drawing them in individually or
continuous for example. Refer to wall topics for these input methods. See Walls

Stretching a section of building using mouse
In 3D Architect Home Designer it’s very simple to ensure you get a floor plan laid out accurately using any of
the various techniques. However, on occasion you may want to ‘pull’ a section of a floor plan to change the
size of an area without affecting the adjoining walls and rooms.

1. With the walls in place already we need to select the correct editing tool.

2. From the left tool menu bar click the Editing tools icon 

3. In the Tools catalog on right of screen, left-click the Move/Rotate folder  to open a
selection of tools to enable different editing effects to be applied to existing elements.

4. Left-click the Stretch tool 

5. The Stretch tool utilizes a standard polygon area to define which part of the building is included in the
stretch area. Anything not included in the polygon will be left in its current position.

6. With the Stretch tool selected, using the mouse to click each corner of the polygon, select the area to be
included in the zone to be ‘pulled’.
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7.  
8. When the area has been defined, press Esc on your keyboard to lock the area.
9. Now, simply click on one of the included elements e.g. below to use as reference point

10.Move your mouse and you will see the effect of the movement on-screen e.g.
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11.Pull out walls to new location and left-click to place it. The room has now been stretched to its new size
e.g.

12.Try combining this technique with the use of guidelines and/or rulers to ensure accurate re-placement of
the selected elements.

Stretching a section of building using numeric input
In 3D Architect Home Designer it’s very simple to ensure you get a floor plan laid out accurately using any of
the various techniques. However, on occasion you may want to ‘pull’ a section of a floorplan to change the
size of an area without affecting the adjoining walls and rooms.

1. With the walls in place already we need to select the correct editing tool.

2. From the left tool menu bar click the Editing tools icon 
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3. In the Tools catalog on right of screen, left-click the Move/Rotate folder  to open a
selection of tools to enable different editing effects to be applied to existing elements.

4. Left-click the Stretch tool 

5. The Stretch tool utilizes a standard polygon area to define which part of the building is included in the
stretch area. Anything not included in the polygon will be left in its current position.

6. With the Stretch tool selected, using the mouse to click each corner of the polygon, select the area to be
included in the zone to be ‘pulled’.

7. When the area has been defined, press Esc on your keyboard to lock the area.

8. Now, simply click on one of the included elements e.g. below to use as reference point.



3D Architect Home Designer

137

9. Using your keyboard type in the distance you would like walls pulled out to (from reference point above).
The Distance field in the Numeric input bar at bottom of screen will highlight.

10.Next press the TAB key. The Angle field in the Numeric input bar at bottom of screen will highlight.

11.Using your keyboard type in desired angle. Press the Enter key or click the Apply button in numeric input
bar. The room has now been stretched to its new size e.g.
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Transferring properties from one wall to another

1. Click the Selection icon  from the tool menu bar on left and left-click a wall segment in your floor
plan you would like to modify.

1. Go to the Edit menu and click Select properties.

2. Left-click element(s) you would like to transfer properties to (hold down the Shift key to multi select)
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Note: If you are applying this to walls that have been drawn using polygonal input, ensure that the walls are
not grouped otherwise you will not be able to select/edit walls individually. Walls that have been grouped
together can be ungrouped after they have been drawn by clicking on a wall and then clicking the green
ungroup symbol attached to wall group. You can also ungroup walls through the Edit menu.

3. In the Edit menu select the entry Transfer properties and press Esc. 
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5. If for example you find that by transferring properties from one wall to another has affected some corners
where the walls join e.g. below, use the Miter walls (L) tool to trim walls together to form corner. See
Trimming walls together
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Trimming walls together

1. Left-click the Editing Tools icon  in the left vertical bar and then left-click the Modify Walls folder in
catalog on right.
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2. Left-click the Miter walls (L) icon 

  

3. Move the mouse cursor over to the first trim wall. The active wall will highlight in green.



3D Architect Home Designer

143

4. Left click on this wall and then move your cursor over to the second trim wall. This wall will highlight green
too.

5. The selected walls to trim together are adjusted such that the end of the wall axis is positioned precisely
on the intersection with another wall axis.

6. On selection of walls, left click again to trim these two walls together and form a corner. 

Note: If you are applying this to walls that have been drawn using polygonal input, ensure that the walls are
not grouped otherwise you will not be able to select/edit walls individually. Walls that have been grouped
together can be ungrouped after they have been drawn by clicking on a wall and then clicking the green
ungroup symbol attached to wall group. You can also ungroup walls through the Edit menu.

Drawing upper and lower beams using parallel input tool

1. From the left tool menu bar click the Wall tool 

2. In the Beams/Walls catalog to right of screen, left-click the Upper Beams folder  to
open a selection of beam types.

3. Select a beam type and select the placement option Parallel Wall .

4. In the Tool Options Header bar click the tab for Upper Beams. If using Lower Beam, the dialog box will be
displayed as Lower Beam.
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5. In the dialog box that appears you can specify its thickness and height before drawing beam in position.
You can access this dialog box and modify the properties of beam later on by clicking a beam segment in
your plan followed by the same Upper Beam tab in Tool Options Header bar. 

6. Confirm settings by closing dialog box.

7. Move your cursor over reference wall (the cursor will snap to reference wall) and left-click. Your beam will
be created parallel to this wall (the reference wall)

8. After first click the following dialog box will appear where you can enter the offset distance i.e. the distance
the beam will be drawn parallel to reference wall.

9. Confirm settings with OK.

10.A guideline will attach itself to cursor at specified distance.
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11.Left-click to set distance and position of guideline for drawing beam to.

12.Now left-click again to set the start point of beam e.g. below.

13.The beam will attach itself to guideline together with dimensions. By moving your cursor, the length of
beam will change.

Note: Ensure the position is correct and if necessary use the key combination Ctrl + W to toggle between the
beam edges and axis. This lets you define which beam edge you wish to place against guideline e.g. the
inside edge of beam, center line of beam or outside edge of beam.

14.Finally, when you have determined wall length, left-click to set the end point of wall.

15.Repeat above steps to continue drawing beams in this way.
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Beam display in 3D

Note: You can cancel the beam function at anytime with the Esc key or by right-clicking and selecting
Cancel Function.

Note: You draw beams in the same way as normal walls as described in previous topics. Please refer to
these on how to draw continuous beams or beams to exact length for example.See Walls

Note: You can change the 2D display of beam at any time by clicking a beam segment in your plan and
selecting the Display tab in the Tool Options Header bar. Before drawing beam in position you can also
change the display properties by selecting a beam type in catalog and clicking the same Display tab in Tool
Options Header bar.

Changing length of wall using in-line measurements
1. This operation can be carried out in both 2D Construction and 3D Furnishing mode.

2. In 2D mode, click the Selection icon  from the tool menu bar on left and left-click the wall in your
floor plan you wish to change length of.

3. By default, the in-line measurement will display on-screen associated with element but if not locate option
through the menu View > In-line Measurements

1. Left-click the in-line measurement that appears. An input box for entering new value will appear.
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2. With padlocks undone, the wall length will change from the center point proportionally. By clicking the
padlock you are able to lock either end of wall in order to change length in one direction only.

Note: If you are applying this method to walls that have been drawn using polygonal input, ensure that the
walls are not grouped otherwise you will not be able to select/edit walls individually.  Walls that have been
grouped together can be ungrouped after they have been drawn by clicking on a wall and then clicking the
green ungroup symbol attached to wall group. You can also ungroup walls through the Edit menu.

Changing length of wall through the size and position dialog box
1. This operation can be carried out in both 2D Construction and 3D Furnishing mode.

2. In 2D mode, click the Selection icon  from the tool menu bar on left and left-click the wall in your
floor plan you wish to change length of.

3. In the Tool Options Header bar click the tab for Size and Position
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4. In the dialog box that appears set the reference between to determine direction of length e.g. below

Click left corner point to lengthen wall from left reference point:

or click top center point to lengthen wall from reference point in both directions

or click right corner point to lengthen wall from right reference point
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5. Select the appropriate dimension (L) in the graphic or go to the corresponding tab entry in table view
(circled below) to activate the input field for the wall length.

6. The value in the input field can be changed in various ways. Place the cursor e.g. to after the '0'. The value
to the left of the cursor is always changed. Rotate the mouse wheel to change the value up or down.
Instead of the mouse wheel you can also use the keyboard's arrow keys, the arrows to the right of the
input field or enter values direct using keyboard to overwrite values.
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7. Changes made in 3D / 2D mode are immediately visible. In combination with the in-line parameters, the
components with the input fields are changed in real time.

Adjusting the height of individual walls

1. Switch to 3D Furnishing mode 

2. Click the Selection icon  from the tool menu bar on left and left-click a wall segment in your floor
plan you would like to modify.

1. In the Tool Options Header bar click the tab for Wall.

3. In the Wall options dialog box that opens click the Levels tab to display following.

4. To adjust wall levels click the symbols on the interactive graphic as follows.
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5. The symbols circled below allow you to adjust upper/lower level of wall sides at same height or individually.
A tick means that both sides will be at same level whereas a cross means that wall sides can be changed
individually.

6. Left-clicking the black arrow symbols circled below allow you to adjust the wall levels using the top-left,
bottom-left, top-right and bottom-right of wall as a reference point to offset height. The input box that
appears after clicking symbol allows you to increase or reduce level of wall by entering new value. 

7. After entering new value in input field you will see the changes instantly in 3D.
 
8. The symbols circled below determine level relative to floor construction.
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9. Clicking the button As Floor will reset values to storey height as defined in Floors dialog box.

Note: To change storey height of entire floor go to menu (Floors > Edit Active Floor > Height tab)

Updating existing wall to a different construction type

1. Click the Selection icon  from the tool menu bar on left  and left-click a wall segment in your floor
plan you would like to modify.

2. In the Tool Options Header bar click the tab for Wall.

3. The following Wall options dialog box will open.
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4. In the top-right of window click the icon for Load wall construction from the database 

5. In the dialog box that appears select a new wall construction from catalog and select OK to confirm
settings.

6. The changes are instantly visible on screen.

7. Repeat this for other walls or use the Transfer properties option.

Modifying wall properties - creating new construction layers
1. Draw a wall segment on to your work sheet

Note: By editing a wall on your sheet rather than from the catalog will not affect existing wall properties in
catalog. You can also see instant effect on screen when making changes to wall properties. New
construction walls can be saved to database.

1. Click the Selection icon  from the tool menu bar on left and left-click a wall segment in your floor
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plan you would like to modify.

2. In the Tool Options Header bar click the tab for Wall.

3. The following Wall options dialog box will open.

4. Under the Layers tab there is a section for adding and removing outside and inside layers by clicking on
the symbols circled below
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5. Here you are able to create additional layers (+ symbol) and remove unwanted ones (- symbol).

6. On creation of new layer click on relevant input fields:

7. To update title to open drop down list of layer names or overwrite these by typing in your own:

8. Click the thickness field to enter new value:

9. Click in hatching style to enter new pattern:

10.For advanced settings to layer properties, click hatching style followed by symbol next to it for Edit
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hatching detail and Edit Fill detail.

11.A dialog box will appear where you can make individual changes to hatching/fill style. 

12.When you have created a new wall construction you can save this to the database by clicking the icon for 
Save current wall construction to the database.

13.A Save dialog box will appear.

14.Click the button for New directory. Provide a name for directory e.g. 'My Walls' and click OK.

15.Now provide your new wall construction with a name e.g. 'New wall 1' and click OK.

16.Close dialog boxes and access the Beams/Walls catalog. Under Walls section a new directory e.g. 'My
Walls' will be created containing your new wall construction e.g. 'New wall 1'. You can add to this folder at
anytime.

Note: In the catalog view, any new construction items stored under your directory can be renamed or deleted
by right-clicking item.

Rooms
See also

Variable room input
Rotated room input
Default room input

Selecting  the  Room  tool   from  the  Tool  Menu  Bar  displays  the  placement  options  in  the  Tool
Placement Context Bar together with a selection of room types in the Tool Options Catalogue.
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An alternative method to creating floor-plans from individual walls is to use the Room tool . The room
tool  enables  you  to  create  a  floor-plan  by  using  drag  and  drop  pre-defined  room  shapes  from  the  Tool
Options Catalogue. These pre-formed shapes can be sized as required and by locating rooms next to each
other you can quickly establish a complete floor.

Hovering  your  mouse  over  the  Rooms  icon  will  also  display  recently  used  room  shapes  which  can  be
selected directly from the fly-out menu.

Room/Wall  properties  are  fully  customizable  using  the  options  in  the  Tool  Options  Header  Bar.  These
options enable you to set wall materials, 2D display details, hatching patterns etc. Of course, you can modify
a wall before inserting it in to your drawing but walls that have already been inserted can also be modified at
any stage in your project. Just select a wall element by left-clicking it (see Selection Tool) (ensure you are
on correct floor and the element is not protected/locked from further editing) and use the options in the Tool
Options Header Bar. Because the wall has already been inserted in to your drawing, on selection, additional
options may become available in the Tool Options Header Bar e.g.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Once your rooms have been added, they can then be split into the component wall parts through the menu
Edit > Convert rooms in to individual walls which can then be edited further as with any other standard
wall element.

Variable room input

Variable room input 

1. From the left tool menu bar click the Rooms tool 

2. In the Rooms catalog on right of screen, a selection of room types become available.

3. Select a room e.g. Rectangular room followed by the placement option for variable input (depending
on room shape the number of input steps will vary).
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4. Left-click on the work sheet to set the start point of room.

5. Move your cursor and the wall will follow the direction of the cursor together with its length.

6. Left-click to set the second corner point of room.

7. Move your cursor to define final wall length and left-click to set room in position e.g. below
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8. Move your cursor over to room and it will highlight with a set of arrows on each wall.

9. Left-click room and wall lengths will appear for that room. A room with more sides will display more
lengths.

10.On one of the walls, left-click a wall length and an input box for entering new value will appear.
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11.Enter new a value using arrows (the wall length will change instantly on screen) or type in value and press
the Enter key. The wall length / room size will change.

12.Repeat this for any other walls displaying lengths.

13.You can add multiple rooms this way by snapping them on together and then changing size as described
above.

14.On completing room, you need to convert the room walls back to standard wall elements. This allows you
to edit walls individually and for adding other elements to e.g. windows, doors etc. To do this, select the
menu option 'Edit > Convert Rooms in to Individual Walls'  

Note: Depending on what room you choose, the number of input steps will vary in order to draw out the
individual wall lengths.

Below is an example of inputting a Room with Bay. 

1. Left-click set start point.
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2. Move cursor to define length and left-click to set next corner point.

3. Move cursor to define next length and left-click to set third corner point.
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4. Move cursor to define next wall length up to bay wall and left-click to set fourth corner point.

5. Move cursor to define length and angle of first bay wall and left-click to set fifth corner point.
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6. Move cursor to define length of horizontal bay wall and left-click to set sixth corner point.

7. Move cursor to define length and angle of final bay wall and left-click to create room.
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8. Left-click on room to display wall lengths and input boxes for entering new values.

9. On completing room, you need to convert the room walls back to standard wall elements. This allows you
to edit walls individually and for adding other elements to e.g. windows, doors etc. To do this, select the
menu option 'Edit > Convert Rooms in to Individual Walls'  
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Rotated room input

Rotated room input 

1. From the left tool menu bar click the Rooms tool 

2. In the Rooms catalogue on right of screen, a selection of room types become available.

3. Select a room e.g. Rectangular room followed by the placement option for rotated room input 
(depending on room shape the number of input steps will vary).

4. Inputting a room this way is similar to using the Variable room input option however when you set the start
point, you can determine the room angle and length by moving the cursor. 

5. Left-click on the work sheet to set the start point of room.

6. Move your cursor and the wall will follow the direction of the cursor together with its length.

7. Left-click to set the second corner point of room.
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8. Move your cursor to define final wall length and left-click to set room in position e.g. below.

9. As described in the section Variable room input, move your cursor over to room and it will highlight with a
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set of arrows on each wall.

10.Left-click room and wall lengths will appear for that room. A room with more sides will display more
lengths.

11.On one of the walls, left-click a wall length and an input box for entering new value will appear.

12.Enter new a value using arrows (the wall length will change instantly on screen) or type in value and press
the Enter key. The wall length / room size will change.

13.Repeat this for any other walls displaying lengths.

14.You can add multiple rooms this way by snapping them on together and then changing size as described
above.

15.On completing room, you need to convert the room walls back to standard wall elements. This allows you
to edit walls individually and for adding other elements to e.g. windows, doors etc. To do this, select the
menu option 'Edit > Convert Rooms in to Individual Walls' 

Default room input

Default room input 

1. From the left tool menu bar click the Rooms tool 
2. In the Rooms catalogue on right of screen, a selection of room types become available.

3. Select a room e.g. Rectangular room followed by the placement option for default room 

4. Through one left-click, place room directly on to to work sheet.

5. As described in the section Variable room input, move your cursor over to room and it will highlight with a
set of arrows on each wall.

6. Left-click room and wall lengths will appear for that room. A room with more sides will display more
lengths.

7. On one of the walls, left-click a wall length and an input box for entering new value will appear.

8. Enter new a value using arrows (the wall length will change instantly on screen) or type in value and press
the Enter key. The wall length / room size will change.

9. Repeat this for any other walls displaying lengths.

10.You can add multiple rooms this way by snapping them on together and then changing size as described
above.

11.On completing room, you need to convert the room walls back to standard wall elements. This allows you
to edit walls individually and for adding other elements to e.g. windows, doors etc. To do this, select the
menu option 'Edit > Convert Rooms in to Individual Walls' 

Doors
See also:

Insert door at a set distance
Insert door freely
Insert door midway between two points
Changing the stop and direction of door opening
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Selecting  the  Door  tool   from  the  Tool  Menu  Bar  displays  the  door  placement  options  in  the  Tool
Placement Context Bar together with the pre-set door types currently in the database, which can be chosen
from the Tool Options Catalogue.

Using the Door tool   enables you to add doors to the existing walls of your building. All doors need to
be  placed  into  a  wall  on  the  plan.  You  do  not  need  to  create  space  for  the  door  as  the  cut-out  will  be
generated automatically once you add the selected door to the wall.



Construction Mode Tool Menu Bar

170

In  the  catalog,  those  icons  identified  with  a  small  yellow  windows  folder  symbol  can  be  accessed  by  left-
clicking to reveal  the subset  of  options.  Depending on what tool  you  are  accessing,  there  could  be further

sub-folders  to click.  With the following icon  you can move up one folder  in  the directory  structure.  By

clicking the  icon you always move first into the folder that was last opened and by clicking the icon next

to it  returns you back to top of directory.

The placement of doors in walls can be completed with one of three placement options: Free Placement is a
drag  and  drop  option  to  set  your  door  location  manually  (ideally  combined  with  guidelines  for  specific
placement).  Set  Distance  provides  the  option  to  set  the  door  a  specific  distance  away  from  a  chosen
reference  point.  Midway  requires  you  to  define  two  points  on  your  plan;  the  door  will  then  be  set  exactly
midway between these two points.

Doors  can  be  completely  customized  using  the  options  in  the  Tool  Options  Header  Bar  including  the
component  editor  which  allows  you  to  change  all  of  the  constituent  parts  of  the  door  including  handles,
hinges, panels etc. Of course, you can modify a door before inserting it in to your drawing but doors that have
already been inserted can also be modified at any stage in your project. Just select a door by left-clicking it
(see Selection Tool) (ensure you are on correct floor and the element is not protected/locked from further
editing) and use the options in the Tool Options Header Bar. Because the door has already been inserted
in to your drawing, on selection, additional options may become available in the Tool Options Header Bar e.
g.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Hovering  your  mouse  over  the  Doors  icon  will  also  display  recently  used  doors  which  can  be  selected
directly from the fly-out menu.

Insert door at a set distance

1. From the left tool menu bar click the Door tool 

2. In the Doors catalog on right of screen, is a selection of door types and additional folders. Select a door
type.

3. In the Tool Options Header bar click the tab for Component.
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4. In the dialog box that appears, a preview of door will display. In addition to changing component height,
width etc, the dialog box consists of a number of tabs to fully customize the door including all of the
constituent parts of the door including handles, hinges, panels etc. 

Note: The dialog box can be left open if you want to select and preview another door type from catalog. The
preview and properties of selected door will update accordingly in dialog box. The dialog box can be left open
for making further changes and closed by clicking the cross in the top right. All settings will be retained in
dialog box for future access.

5. Under the Style tab, locate the following graphic for adjusting the width, height and sill height of door.
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6. Left-click on the horizontal arrow (highlighted red) and in the input box enter a new value.

7. Repeat and click the other arrows on graphic entering new values for height and sill.

Note: You can also make these changes by clicking relevant parts of graphic shown in preview window e.g.
below.

8. Close the dialog box and select the placement method for Door at Set Distance in the tool placement
context bar.

9. Click the Tool options icon in the top tool options header bar. 

10.In the dialog box that appears enter an offset value e.g. 3 ft. The offset value will set the distance from the
reference point to the edge of door or to center point of door if this option has been selected below i.e. 
Distance to the center.

11.After setting all parameters you can now insert the door in the following way.

12.Left-click on wall to specify the reference point.
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13.Left-click again to position door on wall.

14.Before the 3rd and final click, move the cursor around door to determine the stop and direction of door
opening. By moving mouse the opening symbol will move in direction of cursor e.g.

  

15.Once you have determined the stop and direction of opening, left-click to insert door in to wall.
 
16.The door is now in position at an offset distance of e.g. 3 ft from reference point as specified in the Tool

Options dialog box.
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Insert door freely

1. From the left tool menu bar click the Door tool 

2. In the Doors catalog on right of screen, is a selection of door types and additional folders. Select a door
type.

3. In the Tool Options Header bar click the tab for Component.

4. In the dialog box that appears, a preview of door will display. In addition to changing component height,
width etc, the dialog box consists of a number of tabs to fully customize the door including all of the
constituent parts of the door including handles, hinges, panels etc. 

Note: The dialog box can be left open if you want to select and preview another door type from catalog. The
preview and properties of selected door will update accordingly in dialog box. The dialog box can be left open
for making further changes and closed by clicking the cross in the top right. All settings will be retained in
dialog box for future access.
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5. Under the Style tab, locate the following graphic for adjusting the width, height and sill height of door.

6. Left-click on the horizontal arrow (highlighted red) and in the input box enter a new value.

7. Repeat and click the other arrows on graphic entering new values for height and sill.

Note: You can also make these changes by clicking relevant parts of graphic shown in preview window e.g.
below.

8. Close the dialog box and select the placement method for Door Free Positioning in the tool placement
context bar

9. Click the Tool options icon in the top tool options header bar. 

10.In the dialog box that appears you can select the placement reference point of door from drop down list.
The cursor will attach itself to left, right or center point of door. You can also use the key combination Ctrl
+ W to toggle between reference points.
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11.Close dialog box and move your mouse cursor over to where you want the door inserted in to wall.

12.Place the door by first left-clicking on the desired position on existing wall.

13.Move the cursor around door to determine the stop and direction of door opening. By moving mouse the
opening symbol will move in direction of cursor.

14.Once you have determined the stop and direction of opening, left-click to insert door in to wall. 

Insert door midway between two points

1. From the left tool menu bar click the Door tool 

2. In the Doors catalog on right of screen, is a selection of door types and additional folders. Select a door
type.

3. In the Tool Options Header bar click the tab for Component.

4. In the dialog box that appears, a preview of door will display. In addition to changing component height,
width etc, the dialog box consists of a number of tabs to fully customize the door including all of the
constituent parts of the door including handles, hinges, panels etc. 
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Note: The dialog box can be left open if you want to select and preview another door type from catalog. The
preview and properties of selected door will update accordingly in dialog box. The dialog box can be left open
for making further changes and closed by clicking the cross in the top right. All settings will be retained in
dialog box for future access.

5. Under the Style tab, locate the following graphic for adjusting the width, height and sill height of door.

6. Left-click on the horizontal arrow (highlighted red) and in the input box enter a new value.

7. Repeat and click the other arrows on graphic entering new values for height and sill.

Note: You can also make these changes by clicking relevant parts of graphic shown in preview window e.g.
below.
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8. Close the dialog box and select the placement method for Door Midway in the tool placement context bar.

9. Move your mouse cursor over to where you want the door inserted in to wall.

10.The door will be positioned midway between two references points.

11.Left-click to set the first reference point. 

12.Left-click again to set the second reference point. A guideline will appear midway between these two
points indicating where the door will be placed. 

13.Move the cursor over to guideline and the door will attach itself to it through its center point.

14.Confirm position by left-clicking on wall.
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15.Move the cursor around door to determine the stop and direction of door opening.

16.Once you have determined the stop and direction of opening, left-click to insert door in to wall. 

1.

Changing the stop and direction of door opening

1. Click the Selection icon  from the tool menu bar on left and left-click a door in your floor plan you
would like to modify.

2. This can be done in both 2D and 3D modes.
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3. In the Tool Options Header bar click the tab for Component.

4. In the Component dialog box that appears, under the Style tab, locate the following graphics.

5. Left-click on highlighted arrows below to switch door left or right e.g. hinge door on the left instead of on
the right. You will see the changes instantly on screen.

   

6. Left-click on highlighted arrows below to switch door front and back e.g. open door inwards instead of
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outwards. You will see the changes instantly on screen.

   

Note: The dialog box can be left open if you want to select and change opening for another door in your floor
plan.

Windows & Cut-outs
See also:

Insert window at set distance
Insert window freely
Insert window midway between two points
Changing the stop and direction of window opening
Simplify 2D symbol of windows - do not show direction of opening

Selecting  the  Window  tool   from  the  Tool  Menu  Bar  displays  the  window  placement  options  in  the
Tool Placement Context Bar together with the pre-set window types currently in the database, which can be
chosen from the Tool Options Catalogue.
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The  Window  tool    enables  you  to  add  windows  &  separate  cutouts  to  the  existing  walls  of  your
building.  All  windows  need  to  be  placed  into  a  wall  on  the  plan.  You  do  not  need  to  create  space  for  the
window as the cut-out will be generated automatically once you add the selected window to the wall.

In  the  catalog,  those  icons  identified  with  a  small  yellow  windows  folder  symbol  can  be  accessed  by  left-
clicking to reveal  the subset  of  options.  Depending on what tool  you  are  accessing,  there  could  be further
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sub-folders  to click.  With the following icon  you can move up one folder  in  the directory  structure.  By

clicking the  icon you always move first into the folder that was last opened and by clicking the icon next

to it  returns you back to top of directory.

The placement of windows in walls can be completed with one of three placement options: Free Placement
is a drag and drop option to set your window location manually (ideally combined with guidelines for specific
placement).  Set  Distance  provides  the  option  to  set  the  window  a  specific  distance  away  from  a  chosen
reference point. Midway requires you to define two points on your plan; the window will then be set exactly
midway between these two points.

Windows can be completely  customized using the options in  the Tool Options Header Bar  including  the
component  editor  which  allows  you  to  change  all  of  the  constituent  parts  of  the  door  including  handles,
hinges,  panels etc.  Of course, you can modify a window before inserting it  in  to your  drawing but  windows
that have already been inserted can also be modified at any stage in your project. Just select a window by
left-clicking it (see Selection Tool) (ensure you are on correct floor and the element is not protected/locked
from further editing) and use the options in the Tool Options Header Bar. Because the window has already
been inserted in to your drawing, on selection, additional options may become available in the Tool Options
Header Bar e.g.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Hovering your mouse over the Windows icon will also display recently used windows which can be selected
directly from the fly-out menu.

Insert window at set distance

1. From the left tool menu bar click the Window tool 

2. In the Windows catalog on right of screen, left-click on the Windows folder to open a selection of window
types and additional folders. Select a window type.

3. In the Tool Options Header bar click the tab for Component.
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4. In the dialog box that appears, a preview of window will display. In addition to changing component height,
width etc, the dialog box consists of a number of tabs to fully customize the window including all of the
constituent parts of the window including handles, hinges, panels etc. 

Note: The dialog box can be left open if you want to select and preview another window type from catalog.
The preview and properties of selected window will update accordingly in dialog box. The dialog box can be
left open for making further changes and closed by clicking the cross in the top right. All settings will be
retained in dialog box for future access.

5. Under the Style tab, locate the following graphic for adjusting the width, height and sill height of window.
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6. Left-click on the horizontal arrow (highlighted red) and in the input box that appears enter a new value e.g.
3 ft.

7. Repeat and click the other arrows on graphic entering new values for height and sill.

Note: You can also make these changes by clicking relevant parts of graphic shown in preview window e.g.
below.

8. Close the dialog box and select the placement method for Window at Set Distance in the tool placement
context bar.

9. Click the Tool options icon in the top tool options header bar 

10.In the dialog box that appears enter an offset value e.g. 3 ft. The offset value will set the distance from the
reference point to the edge of window or to center point of window if this option has been selected below
i.e. Distance to the center.
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11.After setting all parameters you can now insert the window in the following way.

12.Left-click on wall to specify the reference point.

13.Left-click again to position window on wall.

14.Before the 3rd and final click, move the cursor around window to determine the stop and direction of
window opening. By moving mouse the opening symbol will move in direction of cursor.  

  

  

15.Once you have determined the stop and direction of opening, left-click to insert window in to wall. 

16.The window is now in position at an offset distance of e.g. 3 ft from reference point as specified in the 
Tool Options dialog box.
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Insert window freely

1. From the left tool menu bar click the Window tool 

2. In the Windows catalog on right of screen, left-click on the Windows folder to open a selection of window
types and additional folders. Select a window type.

3. In the Tool Options Header bar click the tab for Component.

4. In the dialog box that appears, a preview of window will display. In addition to changing component height,
width etc, the dialog box consists of a number of tabs to fully customize the window including all of the
constituent parts of the window including handles, hinges, panels etc. 

Note: The dialog box can be left open if you want to select and preview another window type from catalog.
The preview and properties of selected window will update accordingly in dialog box. The dialog box can be
left open for making further changes and closed by clicking the cross in the top right. All settings will be
retained in dialog box for future access.
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5. Under the Style tab, locate the following graphic for adjusting the width, height and sill height of window.

6. Left-click on the horizontal arrow (highlighted red) and in the input box that appears enter a new value e.g.
3 ft.

7. Repeat and click the other arrows on graphic entering new values for height and sill.

Note: You can also make these changes by clicking relevant parts of graphic shown in preview window e.g.
below.

8. Close the dialog box and select the placement method for Window Free Positioning in the tool
placement context bar

9. Click the Tool options icon in the top tool options header bar.

10.In the dialog box that appears you can select the placement reference point of window from drop down
list. The cursor will attach itself to left, right or center point of window. You can also use the key
combination Ctrl + W to toggle between reference points. 
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11.Close dialog box and move your mouse cursor over to where you want the window inserted in to wall.

12.Place the window by first left-clicking on the desired position on existing wall.

13.Move the cursor around window to determine the stop and direction of window opening. By moving mouse
the opening symbol will move in direction of cursor.

14.Once you have determined the stop and direction of opening, left-click to insert window in to wall. 

Insert window midway between two points

1. From the left tool menu bar click the Window tool 

2. In the Windows catalog on right of screen, left-click on the Windows folder to open a selection of window
types and additional folders. Select a window type.

3. In the Tool Options Header bar click the tab for Component.

4. In the dialog box that appears, a preview of window will display. In addition to changing component height,
width etc, the dialog box consists of a number of tabs to fully customize the window including all of the
constituent parts of the window including handles, hinges, panels etc. 
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Note: The dialog box can be left open if you want to select and preview another window type from catalog.
The preview and properties of selected window will update accordingly in dialog box. The dialog box can be
left open for making further changes and closed by clicking the cross in the top right. All settings will be
retained in dialog box for future access.

5. Under the Style tab, locate the following graphic for adjusting the width, height and sill height of window.

6. Left-click on the horizontal arrow (highlighted red) and in the input box that appears enter a new value e.g.
3 ft.

7. Repeat and click the other arrows on graphic entering new values for height and sill.

Note: You can also make these changes by clicking relevant parts of graphic shown in preview window e.g.
below.
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8. Close the dialog box and select the placement method for Window Midway in the tool placement context
bar.

 

9. Move your mouse cursor over to where you want the window inserted in to wall.

10.The window will be positioned midway between two references points.

11.Left-click to set the first reference point. 

12.Left-click again to set the second reference point. A guideline will appear midway between these two
points indicating where the window will be placed.

13.Move the cursor over to guideline and the window will attach itself to it through its center point.

14.Confirm position by left-clicking on wall.
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15.Move the cursor around window to determine the stop and direction of window opening.

16.Once you have determined the stop and direction of opening, left-click to insert window in to wall. 

Changing the stop and direction of window opening

1. Click the Selection icon  from the tool menu bar on left and left-click a window in your floor plan you
would like to modify.

2. This can be done in both 2D and 3D modes.

3. In the Tool Options Header bar click the tab for Component.
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4. In the Component dialog box that appears, under the Style tab, locate the following graphics.

5. Left-click on highlighted arrows below to switch window left or right e.g. hinge window on the left instead of
on the right. You will see the changes instantly on screen.

   

6. Left-click on highlighted arrows below to switch window front and back e.g. open window inwards instead
of outwards. You will see the changes instantly on screen.

   

Note: The dialog box can be left open if you want to select and change opening for another window in your
floor plan. 

Simplify 2D symbol of windows - do not show direction of opening

1. Click the Selection icon  from the tool menu bar on left and left-click a window in your floor plan you
would like to modify.

2. In the Tool Options Header bar click the tab for Component.

3. In the Component dialog box that appears, under the 2D View tab, left-click the movement graphic
(circled below) and then left-click one of 'window panels' (e.g. left window panel circled) in the main
preview area.
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4. Locate the Level of detail drop down list (circled below) and select Never in order to turn off direction of
opening for e.g. the 'left window panel' you selected above. The window detail will update instantly on
screen.

5. Repeat these steps if you have multiple 'window panels' e.g. below
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Note: The dialog box can remain open if you want to select and change other windows in your floor plan.

Stairs

Selecting the Stairs tool   from the Tool Menu Bar  displays a selection of  standard stair  types in  the
Tool Options Catalogue.
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By default Stairs   are automatically set to the floor-to-floor height of the floor in which they are being
placed. This means as standard they will climb from the floor level of the storey you are working on, to the
floor level of the storey above. This can of course all be adjusted in the Stairs dialogue accessed through the
 Tool Options Header Bar where you can change all the stair settings including construction details.

Stairs are placed using an inverted L-shape placement with polygon points. As you lock each point in, you
can move the stairs around the locked point. The ceiling cut-out for the stairs is created automatically to echo
the shape and size of the drawn stairs. This can be edited independently from the shape of the stairs.

Hovering your mouse over the Stairs  icon will also display recently used stair  types which can be selected
directly from the fly-out menu.

Stair properties are fully customizable using the options in the Tool Options Header Bar. You can modify a
stair before inserting it in to your drawing but stairs that have already been inserted can also be modified at
any stage in your project. Just select a stair by left-clicking it (see Selection Tool) (ensure you are on correct
floor and the element is not protected/locked from further editing) and use the options in the Tool Options
Header Bar. Because the stair has already been inserted in to your drawing, on selection, additional options
may become available in the Tool Options Header Bar e.g.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
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appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.

Ceilings & Cut-Outs

Selecting the Ceiling & Cut-Out tool  from the Tool Menu Bar displays the placement options in the
Tool Placement Context Bar together with the ceiling and cutout tool in the Tool Options Catalogue.
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Under  normal  operation,  3D  Architect  Home Designer  will  automatically  add  a  ceiling  to  a  Room  once  its

walls connect to create a fully enclosed space. The Ceiling & Cut-Out tool  gives a manual option to
either add in a ceiling where it has not been added automatically (e.g. where the space is not fully enclosed)
or to create a cut-out where only a partial ceiling is required (e.g. for a gallery landing).

Both  ceiling  and  cut-outs  are  placed  using  the  polygon  shape  tools  which  are  presented  in  the  Tool
Placement Context Bar once the ceiling and cut-out tool icon is selected.

Ceiling  /  cutout  properties  are  fully  customizable  using  the  options  in  the  Tool  Options  Header  Bar.  Of
course, you can modify a ceiling / cutout  before inserting it in to your drawing but ceilings / cutouts that have
already been inserted can also be modified at any stage in your project. Just select a ceiling / cutout by left-
clicking it (see Selection Tool) (ensure you are on correct floor and the element is not protected/locked from
further  editing)  and  use  the  options  in  the  Tool  Options  Header  Bar.  Because  the  ceiling  /  cutout  has
already been inserted in to your drawing, on selection, additional options may become available in the Tool
Options Header Bar.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Balcony, Veranda, Platform, Terrace
Inserting Balcony, Veranda, Platform, Terrace using placement options below:

Rectangle placement
Rotated rectangle placement
Polygon at fixed width placement
Polygon placement

Adding carport:

Adding carport (placement method: rectangle)
Adding carport (placement method: rotated rectangle)

See also:

Adding railings to balcony

3D Architect Home Designer includes specific tools for major building elements.  The Balcony, Veranda &

Platform tool  provides a series of options in the Tool Options Catalogue to add balconies, verandas,
terraces, carports and generic platforms.

Each element has specific polygon based placement options, accessed from the Tool Placement Context
Bar, together with appropriate customisation options in the Tool Options Header Bar.
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The properties of balconies etc in this section are fully customizable using the options in the Tool Options
Header  Bar.  Of  course,  you  can  modify  a  balcony  for  example  before  inserting  it  in  to  your  drawing  but
elements  that  have already been  inserted can  also  be modified  at  any  stage in  your  project.  Just  select  a
balcony for example by left-clicking it (see Selection Tool) (ensure you are on correct floor and the element
is not protected/locked from further editing) and use the options in the Tool Options Header Bar. Because
this  element  has  already  been  inserted  in  to  your  drawing,  on  selection,  additional  options  may  become
available in the Tool Options Header Bar e.g.

You will notice that most of these tools share the same number of options in the Tool Options Header Bar
for  accessing  individual  properties.  For  example,  there  are  tabs  for  modifying  the  border  properties  e.g.
adding border object such as a railing and specifying sides of balcony or platform you would like this object
added to (no matter what shape you have drawn). There is also an option for switching the roof display on/off
(by default the roof is added automatically to a veranda or carport for example)

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Rectangle placement

Rectangle 

1. From the left tool menu bar click the icon for Balconies, Verandas and Platforms 

2. In the Balconies, Verandas and Platforms catalog on right of screen, left-click one of the items to use in

your floor plan e.g. Balcony.

3. Select the placement method Rectangle (balcony) 

4. Ensure that you are on correct floor depending on what tool you have selected e.g. placing balcony on first
floor rather than ground floor.

5. Set your start point (1) of the rectangle with a left-click.
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6. Move your cursor to resize rectangle and left-click to set the second and final point (2) of rectangle.

Note: You can set the length of rectangle more accurately by typing the number in on your keyboard. The
Distance field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press Enter
key or click the Apply button.

Note: The properties of balconies etc in this section are fully customizable using the options in the Tool
Options Header Bar. Of course, you can modify a balcony for example before inserting it in to your drawing
but elements that have already been inserted can also be modified at any stage in your project. Just select a
balcony for example by left-clicking it (see Selection Tool) (ensure you are on correct floor and the element
is not protected/locked from further editing) and use the options in the Tool Options Header Bar. Because
this element has already been inserted in to your drawing, on selection, additional options may become
available in the Tool Options Header Bar e.g.

You will notice that most of these tools share the same number of options in the Tool Options Header Bar
for  accessing  individual  properties.  For  example,  there  are  tabs  for  modifying  the  border  properties  e.g.
adding border object such as a railing and specifying sides of balcony or platform you would like this object
added to (no matter what shape you have drawn). There is also an option for switching the roof display on/off
(by default the roof is added automatically to a veranda or carport for example).

Rotated rectangle placement

Rotated rectangle 

1. From the left tool menu bar click the icon for Balconies, Verandas and Platforms 

2. In the Balconies, Verandas and Platforms catalog on right of screen, left-click one of the items to use in
your floor plan e.g. Veranda.
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3. Select the placement method Rotated rectangle (veranda) 

4. Ensure that you are on correct floor depending on what tool you have selected e.g. placing balcony on first
floor rather than ground floor.

5. In your floor plan, left-click to set your first point (1). (This is the pivot point which the rectangle is rotated
around).

6. Move your cursor to rotate the rectangle around the first point to determine angle and size and left-click to
set in position (2)
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7. Finally move your cursor and left-click to set final point (3) of rectangle.

Note: In between each left click you can set the length of rectangle more accurately by typing the number in
on your keyboard. The Distance field in the Numeric input bar at bottom of screen will highlight. In addition, if
you’d like to set the angle of the rectangle, press the Tab key straight after entering the length. The Angle
field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press Enter key or click
the Apply button.

Note: The properties of balconies etc in this section are fully customizable using the options in the Tool
Options Header Bar. Of course, you can modify a balcony for example before inserting it in to your drawing
but elements that have already been inserted can also be modified at any stage in your project. Just select a
balcony for example by left-clicking it (see Selection Tool) (ensure you are on correct floor and the element
is not protected/locked from further editing) and use the options in the Tool Options Header Bar. Because
this element has already been inserted in to your drawing, on selection, additional options may become
available in the Tool Options Header Bar e.g.

You will notice that most of these tools share the same number of options in the Tool Options Header Bar
for  accessing  individual  properties.  For  example,  there  are  tabs  for  modifying  the  border  properties  e.g.
adding border object such as a railing and specifying sides of balcony or platform you would like this object
added to (no matter what shape you have drawn). There is also an option for switching the roof display on/off
(by default the roof is added automatically to a veranda or carport for example).

Polygon at fixed width placement

Polygon at fixed width 

1. From the left tool menu bar click the icon for Balconies, Verandas and Platforms 
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2. In the Balconies, Verandas and Platforms catalog on right of screen, left-click one of the items to use in
your floor plan e.g. Veranda.

3. Select the placement method Polygon at fixed width (veranda) 

4. Ensure that you are on correct floor depending on what tool you have selected e.g. placing balcony on first
floor rather than ground floor.

5. Click the Tool option icon in the top tool options header bar 

6. In the dialog box that appears you can determine the width of polygon in the Width field. Enter value and
close box.

7. Set the start point (1) with one left-click.

8. Move your cursor to your next point (2) to create your first set of lines at specified width.

Note: Use the key combination Ctrl + W to toggle between reference points on element. This lets you define
which edge to place in relation to reference point e.g. inside edge, center or outside edge. Try pressing this
key combination a few times to see the effect on screen.

9. From here, drag your cursor again and left click to create another set of lines (3) at same width connected
to the previous drawn lines.

10.Repeat this as many times and complete input by pressing the Esc key or by right-clicking and selecting
Complete element (up to last point drawn) in the context menu that appears.
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Note: The properties of balconies etc in this section are fully customizable using the options in the Tool
Options Header Bar. Of course, you can modify a balcony for example before inserting it in to your drawing
but elements that have already been inserted can also be modified at any stage in your project. Just select a
balcony for example by left-clicking it (see Selection Tool) (ensure you are on correct floor and the element
is not protected/locked from further editing) and use the options in the Tool Options Header Bar. Because
this element has already been inserted in to your drawing, on selection, additional options may become
available in the Tool Options Header Bar e.g.

You will notice that most of these tools share the same number of options in the Tool Options Header Bar
for  accessing  individual  properties.  For  example,  there  are  tabs  for  modifying  the  border  properties  e.g.
adding border object such as a railing and specifying sides of balcony or platform you would like this object
added to (no matter what shape you have drawn). There is also an option for switching the roof display on/off
(by default the roof is added automatically to a veranda or carport for example).

Polygon placement

Polygon 

1. From the left tool menu bar click the icon for Balconies, Verandas and Platforms 

2. In the Balconies, Verandas and Platforms catalog on right of screen, left-click one of the items to use in
your floor plan e.g. Platform.
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3. Select the placement method Polygon (platform) 

4. Set your start point (1) with one left-click.

5. Move your cursor to your next point (2) to create your first line of polygon and left-click.

6. From here, move your cursor again and left click (3) to create another line of polygon that is connected to
the one before.

7. Repeat inputting polygon points until you are back to start point of polygon e.g. below.

8. Complete final point of polygon by left-clicking start point of polygon. You can also press the Esc key or by
right-clicking and selecting Complete element (up to last line drawn) in the context menu that appears. 

Note: In between each left-click (setting new lines), you can set the lines length more accurately by typing
the number in on your keyboard. The Distance field in the Numeric input bar at bottom of screen will
highlight. In addition, if you’d like to set the angle of the line, press the Tab key straight after entering the
length. The Angle field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press
Enter key or click the Apply button.

Note: The properties of balconies etc in this section are fully customizable using the options in the Tool
Options Header Bar. Of course, you can modify a balcony for example before inserting it in to your drawing
but elements that have already been inserted can also be modified at any stage in your project. Just select a
balcony for example by left-clicking it (see Selection Tool) (ensure you are on correct floor and the element
is not protected/locked from further editing) and use the options in the Tool Options Header Bar. Because
this element has already been inserted in to your drawing, on selection, additional options may become
available in the Tool Options Header Bar e.g.
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You will notice that most of these tools share the same number of options in the Tool Options Header Bar
for  accessing  individual  properties.  For  example,  there  are  tabs  for  modifying  the  border  properties  e.g.
adding border object such as a railing and specifying sides of balcony or platform you would like this object
added to (no matter what shape you have drawn). There is also an option for switching the roof display on/off
(by default the roof is added automatically to a veranda or carport for example).

Adding railings to balcony

1. From the tool menu bar on left, click the Selection tool  and left-click the balcony in your floor plan
you wish to add railing to.

2. This can be done in both 2D and 3D mode.

3. In the Tool Options Header bar at top select the tab for Border object.

4. In the dialog box that appear, select option for Show border object and in the drop down list that appears,
select Load object and choose an item from catalog or from file.

5. Click OK and the railings will be added to balcony instantly to view on screen.

6. The size and position of railings can be made through this dialog box and also by accessing the tab for 
Border.

7. With the balcony selected, select the tab for Border side in the Tool Options Header bar.

8. The box below provides you with an outline of balcony. By left-clicking the red outline, you can decide
which sides to apply border object to. You must ensure that the checkbox for Show border object is
selected.
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Adding carport (placement method: rectangle)

Rectangle 

1. From the left tool menu bar click the icon for Balconies, Verandas and Platforms.

2. In the Balconies, Verandas and Platforms catalog on right of screen, left-click the icon for Carport.

3. From the tool placement bar, select Rectangle 

4. Ensure that you are on correct floor depending on what tool you have selected e.g. placing balcony on first
floor rather than ground floor.

5. Set your start point (1) of the rectangle with a left-click.

6. Move your cursor to resize rectangle and left-click to set the second and final point (2) of rectangle.
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Note: You can set the length of rectangle more accurately by typing the number in on your keyboard. The
Distance field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press Enter
key or click the Apply button.

Adding carport (placement method: rotated rectangle)

Rotated rectangle 

1. From the left tool menu bar click the icon for Balconies, Verandas and Platforms.
 
2. In the Balconies, Verandas and Platforms catalog on right of screen, left-click the icon for Carport.

3. From the tool placement bar, select Rotated rectangle. 



3D Architect Home Designer

213

4. Ensure that you are on correct floor depending on what tool you have selected e.g. placing balcony on first
floor rather than ground floor.

5. In your floor plan, left-click to set your first point (1). (This is the pivot point which the rectangle is rotated
around).

6. Move your cursor to rotate the rectangle around the first point to determine angle and size and left-click to
set in position (2)
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7. Finally move your cursor and left-click to set final point (3) of rectangle.

Note: In between each left click you can set the length of rectangle more accurately by typing the number in
on your keyboard. The Distance field in the Numeric input bar at bottom of screen will highlight. In addition, if
you’d like to set the angle of the rectangle, press the Tab key straight after entering the length. The Angle
field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press Enter key or click
the Apply button.

Supports & Chimneys
See also:

Inserting supports & chimneys

Selecting the Supports & Chimneys icon  opens the database for supports, pillars and chimney stacks
in the Tool Options Catalogue. Each element is placed using standard drag and drop functionality. You can
customise each element including size and materials in the Tool Options Header Bar. The options available
will vary depending which element is being selected.
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Support/Pillar  & Chimney  properties  are  fully  customizable  using  the  options  in  the  Tool  Options  Header
Bar.  You  can  modify  these elements  before  inserting  it  in  to  your  drawing  but  elements  that  have  already
been inserted can also be modified at any stage in your project. Just select an element by left-clicking it (see
Selection Tool) (ensure you are on correct floor and the element is not protected/locked from further editing)
and use the options in the Tool Options Header Bar. Because the element has already been inserted in to
your drawing, on selection, additional options may become available in the Tool Options Header Bar.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Inserting supports & chimneys

1. From the left tool menu bar click the icon for Supports and Chimneys 

2. In the Supports and Chimneys catalog on right of screen, left-click one of the items to use in your floor
plan.

 

3. You can now drag and drop the item to your chosen spot on the floor plan.
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Note: If the item needs rotating before placing it in position, use the key combination Ctrl + D. To position
item correctly so that the back edges of item fixes to inside of wall for example, use the key combination Ctrl
+ W to determine object snap point. 

4. To change the dimensions of support or chimney (before or after placing item in to floor plan), select item
and click the tab for Dimensions located in the Tool Options Header bar at top.

5. Here you can assign a different type and adjust its size including height. Selecting the option To ceiling
will keep item to story height as defined in menu (Floors > Edit Active Floor > Height tab). Uncheck this
option and the Height field will become active for entering your own value.

6. To change position of support or chimney in floor plan, select it with the Selection tool  and adjust
values using the inline measurements in either 2D Construction mode or 3D Furnishing mode.

Roofs

Selecting  the  Roof  tool   from  the  Tool  Menu  Bar  displays  the  placement  options  in  the  Tool
Placement Context Bar together with a selection of roof types in the Tool Options Catalogue.
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The flexibility of the Roof  tool  in 3D Architect Home Designer enables complex roof structures to be
created quickly and easily, whilst  also providing tools to create simple, standard roof types and styles. The
roof can be placed directly on top of the walls of your floor, however where practical it is good practice to add
an attic floor on which to place the roof. Whilst it is not necessary for every type of roof, it has the advantage
of enabling you to define where walls display in the roof space (e.g. on a gable end).

Roofs can be placed in a number of ways, as defined in the Tool Placement Context Bar. This can be via
polygon based placement  or  added automatically,  allowing  3D Architect  Home Designer  to  define  the roof
shape based on the shape of the floor plan.

Hovering  your  mouse over  the Roof  icon will  also  display  recently  used  roof  types  which  can  be  selected
directly from the fly-out menu.

The options presented in the Tool Options Header Bar for roofs, offers substantial levels of control over all
aspects of the roof construction (pitch, overhang, eaves height etc.) which can be applied to the entire roof or
to  each  side  individually.  You  can  modify  a  roof  before  inserting  it  in  to  your  drawing  but  a  roof  that  has
already been inserted can also be modified at any stage in your project. Just select the roof by left-clicking it
(see Selection Tool) (ensure you are on correct floor and the element is not protected/locked from further
editing) and use the options in the Tool Options Header Bar. Because the roof has already been inserted in
to your drawing, on selection, additional options may become available in the Tool Options Header Bar. e.g.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Dormers

Selecting  the  Dormer  tool   from  the  Tool  Menu  Bar  displays  the  placement  options  in  the  Tool
Placement Context Bar together with a selection of dormer types in the Tool Options Catalogue.
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A  Dormer  is  a  common  feature  in  many  home  extension  and  self-build  projects.  3D  Architect  Home

Designer  provides  a  specific  tool  to  create  dormer  windows   and  the  associated  Tool  Options
Catalogue  lists  the  dormer  styles  available,  which  covers  all  of  the  standard  dormer  types,  plus  a  roof
terrace option.

Dormers form a part of the finished roof and as such, need to be placed onto an existing roof surface. The
dormer settings will make the adjustments to the roof (cut-out, timbers etc.) automatically to accommodate
the new roof shape due to the addition of the dormer.

Hovering your mouse over the Dormer  icon will  display recently used dormer types which can be selected
directly from the fly-out menu.

Dormer properties are fully customizable using the options in the Tool Options Header Bar allowing you to
make changes to pitch, overhang, eaves height, number of windows (before placement) etc.You can modify
a  dormer  before  inserting  it  in  to  your  drawing  but  a  dormer  that  has  already  been  inserted  can  also  be
modified at any stage in your project. Just select the dormer by left-clicking it (see Selection Tool) (ensure
you are on correct floor and the element is not protected/locked from further editing) and use the options in
the  Tool  Options  Header  Bar.  Because  the  dormer  has  already  been  inserted  in  to  your  drawing,  on
selection, additional options may become available in the Tool Options Header Bar.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Skylights

Selecting  the  Skylights  tool   from  the  Tool  Menu  Bar  displays  the  placement  options  in  the  Tool
Placement  Context  Bar  together  with  the  pre-set  skylight  types  currently  in  the  database,  which  can  be
chosen from the Tool Options Catalogue.
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Skylights  are windows which are specifically designed to place in a roof surface rather than into a wall
like a standard window.

As  all  skylights  only  function  when  placed  into  a  roof,  you  will  need  to  add  your  roof  before  adding  any
required skylights. Skylights  are then placed using the standard drag and drop method (use guidelines to
mark the snap position for accuracy) having selected the skylight type from the Tool Options Catalogue.

Skylights can be completely  customized using the options in  the Tool Options Header Bar  including  the
component  editor  which allows you to change all  of  the constituent  parts  of  the window including  handles,
hinges,  panels  etc.  You  can  modify  a  window before  inserting  it  in  to  your  drawing  but  windows that  have
already been inserted can also be modified at any stage in your project. Just select a window by left-clicking
it (see Selection Tool) (ensure you are on correct floor and the element is not protected/locked from further
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editing)  and  use  the  options  in  the  Tool  Options  Header  Bar.  Because  the  window  has  already  been
inserted  in  to  your  drawing,  on  selection,  additional  options  may  become  available  in  the  Tool  Options
Header Bar e.g.

By  right-clicking  a  placed  element,  you  can  also  access  these  options  directly  in  the  context  menu  that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Objects

In 3D Architect Home Designer furniture, fittings, exterior features and decorative items are accessed from

the Tool Options Catalogue when selecting the Objects icon . The objects database contains a large
volume of individually modeled 3D objects for use in your projects.

In  the  catalog,  those  icons  identified  with  a  small  yellow  windows  folder  symbol  can  be  accessed  by  left-
clicking to reveal  the subset  of  options.  Depending on what tool  you  are  accessing,  there  could  be further

sub-folders  to  click.  With  the  following  icon  you  can  move  up  one  folder  in  the  directory  structure.  By

clicking the  icon you always move first into the folder that was last opened and by clicking the icon next

to it  returns you back to top of directory.

The objects in the database make use of Eleco’s own o2c file format. The o2c format enables 3D objects to
be greatly compressed, allowing the use of multiple objects in a project whilst maintaining small file sizes for
project  files.  Objects  can  be  placed  in  to  your  project  (either  in  2D  or  3D  mode)  using  the  drag  and  drop
method. They can then be scaled, rotated and moved as required.

For more information on the o2c player please see our dedicated o2c website at www.o2c.de/en

http://www.o2c.de/en
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Material

Materials  consist of patterns, colours, textures and images that can be applied to elements within the
3D model to create a visual representation of the proposed design. Materials consist of one or more bmp/jpg
images that can be added to an element using the normal drag and drop method. They can then be scaled,
rotated and moved as required.

3D  Architect  Home  Designer  uses  a  database  to  store  the  Materials  and  there  are  several  thousand  to
choose from. The Materials database is displayed in the Tool Options Catalogue once the Materials icon
is selected. New materials can be added to the database quickly, enabling you to easily expand the choices
available to you.

Hovering your mouse over the Materials icon will also display recently used materials which can be selected
directly from the fly-out menu.

In  the  catalog,  those  icons  identified  with  a  small  yellow  windows  folder  symbol  can  be  accessed  by  left-
clicking to reveal  the subset  of  options.  Depending on what tool  you  are  accessing,  there  could  be further

sub-folders  to  click.  With  the  following  icon  you  can  move  up  one  folder  in  the  directory  structure.  By

clicking the  icon you always move first into the folder that was last opened and by clicking the icon next

to it  returns you back to top of directory.
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Material Area

The Material  Area  tool   enables you to quickly mark-out  a section of a wall  to allow the use of  more
than one material on a single wall. This is achieved by double left-clicking on the wall itself in the plan. This
will open an elevation view of the specific wall. Select the method for marking out the area using the options
in the Tool Placement Context Bar and then draw the masked out area by placing the appropriate polygon
points.

Once you have mapped out a Material Area a separate material can be added specifically to this area which
differs  from the rest  of  the wall.  This  makes  is  ideal  to  mark  out  half-render/half-brick  wall  decorations  for
example.

Terrain/Height Points

Selecting the Terrain / Height point tool  from the Tool Menu Bar displays the placement options in
the Tool Placement Context Bar together with a selection of terrain types in the Tool Options Catalogue.
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Path, Plot, Area, Pond

Selecting the Paths/Plots/Area/Ponds tool  from the Tool Menu Bar displays the placement options in
the Tool Placement Context Bar together with ground tools in the Tool Options Catalogue.
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These tools let you mark out a property area as well as its surrounding ground area. As a rule a building is
placed on a plot area. 3D Architect Home Designer automatically creates the landscape area as soon as you
create a new project e.g.

The whole of this group serves to create a realistic view of the direct environment of the building. In general,
you’ll mark out a property first, then assign a building area to this property, and later define areas such as
paths, roads and patches etc. All areas can be colored and textured individually.

In 3D mode you can assign a different material to landscape e.g. grass texture which can be toggled on/off
and also changed to grid display using the icons in bottom status bar when in 3D mode.
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Plot  

In general, a plot is the area on which an owner builds a house and garden. You can assign textures to the
plot area, in order to illustrate the ground condition and appearance, for example. As a rule, a building is
always entirely situated on a plot area so this tool helps you to establish your boundaries before starting to
draw out your building design. On selection of plot, you can also adjust other settings including embankment
levels, rounding properties by selecting the Embankment options tab in the top bar.
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Selecting the Plot tool displays different placement options in the Tool Placement Context Bar.

Marking out your plot or ground area is carried out in a sequence of steps. On selection of tool and
placement option, the status bar at the bottom of the screen will display a sequence of steps. These steps
and tips will vary depending on the tool selected. For example, if you select the Plot tool followed by the
Rectangle input method the following will appear asking you to set the start point of line sequence. This is
step 1 of this particular sequence. Note, if Tip: Tool Options available appears in status bar this means

that options specific to that tool are available by clicking the icon   in the horizontal icon bar at top.

After you have set the start point you will then be asked to set the second line point. This is step 2.  Ctrl key
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+left-click completes this final step. If you have selected the polygonal input method for example, then you
continue marking out area until you complete  the process using Ctrl+left-click. 

Area  
Areas are meant in 3D Architect Home Designer to identify sections of site including yards, garages, flower
patches, lawns etc. In addition, while a ground area is generally assigned to a plot area, it can be situated –
as in the case of a road – outside of a plot area. You can assign textures to the plot area, in order to illustrate
the ground condition and appearance, for example. On selection of area, you can adjust other settings
including embankment levels, rounding properties by selecting the Embankment options tab in the top bar
as  described above. See Plot section for details on how to mark out your ground area.

Path  
Similarly to ground areas use this tool to mark out paths, roads, driveways at a set width. On selection of this
tool, a number of options tabs appear in top bar for making direct changes to material for example or for
defining width of path. The input methods differ from the other tools in this category. You can mark out a
straight path, polygonal path or a curved path using the spline path input option.

On selection of path, you can adjust other settings including embankment levels, rounding properties by
selecting the Embankment options tab in the top bar. See Plot section for details on how to mark out your
path.
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Pond  
The pond tool works in similar way to the area tool and can be drawn using same input options. A water
material and depth will already have been applied to pond which can be viewed in 3D mode. These
properties can be modified by selecting the Embankment options tab in top bar. See Plot section for details
on how to mark out pond.

Dimensions
See also:

Linear dimension
Linear dimension (specify distance)
Horizontal dimension (specify distance)
Vertical dimension (specify distance)
Chain dimensions (specify distances)
Multiple dimensions
Diameter dimension
Radial dimension
Arc length dimension
Linear dimension (arrow)
Diameter dimension (arrow)
Radial dimension (arrow)
Angle dimension

Selecting the Dimensions tool  from the Tool Menu Bar displays a large selection of tools in the Tool
Options Catalogue for dimensioning your drawing.
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Plans drawn in 3D Architect Home Designer are always to scale (which itself is configurable) and as such,

can  easily  be labeled  with  accurate  Dimensions  .  There  are  multiple  dimension  types  which  can  be
selected  from  the  Tool  Options  Catalogue  including  dimension  chains,  angle  dimensions  and  automatic
room dimensions.

Dimensions are generally placed by selecting the dimension points and then selecting where on the page
the dimension will be displayed. There are many options for the display of dimensions in the Tool Options
Header  Bar.  You  can  modify  a  dimension  before  inserting  it  in  to  your  drawing  but  dimensions  that  have
already  been  inserted  can  also  be  modified  at  any  stage  in  your  project.  Just  select  a  dimension  by  left-
clicking it  (see Selection Tool)  (ensure you are on correct  floor and the dimension is not protected/locked
from  further  editing)  and  use  the  options  in  the  Tool  Options  Header  Bar.  Because  the  dimension  has
already been inserted in to your drawing, on selection, additional options may become available in the Tool
Options Header Bar e.g.

By right-clicking placed dimension on sheet, you can also access these options directly in the context menu
that appears. Other options are also available. The context menu also includes an entry for Properties. This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Linear dimension

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Linear dimension

3. Hover your cursor over the wall/edge you’d like to measure (it should highlight red).
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4. Left-click and move your cursor in either direction parallel to the wall being measured. This will drag a new
line out in black with the measurement displayed in the middle.

5. Left-click again to secure the line displaying the length into your desired position.
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Linear dimension (specify distance)

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Linear dimension (specify distance) 

3. Firstly set the desired starting point of the dimension. From the starting point you can measure out a length
to any angle by moving your cursor in any direction.
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4. Now set the end point to measure a section of the wall.

Note: If you’d like to measure out a specific distance from the starting point, before left-clicking to set your
end point, you can simply enter the number on your keyboard and press Enter.

 

5. Move your cursor in either direction parallel to the wall being measured. This will drag a new line out in
black with the measurement displayed in the middle for clear viewing. Left click to secure its position.
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Horizontal dimension (specify distance)

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Horizontal dimension (specify
distance)

3. Left click where you’d like to measure horizontally from (starting point). This can be anywhere on the
project.
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4. Move your cursor either left or right until you have reached the point you’d like to measure to and left-click.

5. Next, move cursor to position dimension and then left-click to secure its position.
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Vertical dimension (specify distance)

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Vertical dimension (specify distance)

3. Left-click where you’d like to measure vertically from (starting point). This can be anywhere on the project.

4. Move your cursor either up or down until you have reached the point you’d like to measure to and left-click.
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5. Next, move cursor to position dimension and then left-click to secure its position.

Chain dimensions (specify distances)

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Chain dimensions (specify distance)
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3. Left-click to set the starting point of first chain dimension.

4. Move cursor to desired end point of first chain dimension and left-click.

5. Next, place the dimension line at your desired location e.g. below and left-click to position it.

6. Continue next chain dimension by left-clicking at desired end point e.g. to end of window below and then to
corner point of wall. Any number of dimensions can be included in chain.

7. On completing last chain dimension with a left-click, press the Esc key to complete chain. 

Multiple dimensions

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Multiple dimensions. 
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3. Left-click to set the starting point of first dimension.

4. Move cursor to desired end point of first dimension and left-click.

5. Next, move cursor to place the dimension line at your desired location e.g. below and left-click to position
it.

6. A new dimension line will appear near to the first one and is set at the same start point.

7. Move cursor to desired end point of second dimension and left-click. A new dimension line will appear as
before. Continue placing multiple dimensions in this way.
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8. On completing last dimension with a left-click, press the Esc key to complete multiple dimensions. 

Diameter dimension
Note: These dimensions only apply to elements drawn using the 2D drawing tools and guidelines.
 

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Diameter dimension. 

3. Hover cursor over to circle/arc outline - it will highlight green.

4. Left-click to select circle/arc.

5. Move your cursor to position dimension line.

6. Finally, left-click to secure its position.

Radial dimension

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Radial dimension. 

3. Hover cursor over to circle/arc outline - it will highlight green.



3D Architect Home Designer

245

4. Left-click to select circle/arc.

5. Press the Esc key to secure its position.

Arc length dimension

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Arc length dimension. 

3. Hover cursor over to arc outline - it will highlight green.

4. Left-click to select arc.

5. Move your cursor to position dimension line.

6. Finally, left-click to secure its position.
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Linear dimension (arrow)

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Linear dimension (arrow).

3. Hover your cursor over the wall/edge you’d like to measure (it should highlight red) and left-click.

4. Move your cursor to position pointer.

 

5. Left-click and then move cursor to position dimension line data.

6. Finally, left-click to secure its position.

Diameter dimension (arrow)

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Diameter dimension (arrow). 
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3. Hover cursor over to circle/arc outline - it will highlight green.

4. Left-click to select circle/arc.

5. Move your cursor to position pointer.

6. Left-click and then move cursor to position dimension line data.

7. Finally, left-click to secure its position.
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Radial dimension (arrow)

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Radial dimension (arrow). 

3. Hover cursor over to circle/arc outline - it will highlight green.

4. Left-click to select circle/arc.

5. Move your cursor to position pointer.

6. Left-click and then move cursor to position dimension line data.
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7. Finally, left-click to secure its position.

Angle dimension

1. From the left tool menu bar click the icon for Dimensions 

2. In the Dimension catalog on right of screen, left-click the icon for Angle dimension.

3. To place an angle where two walls join for example, left-click the inside edge of first wall to use reference
line and left-click.

4. Move your cursor to inside edge of joining wall to use as second reference line and left-click.

5. Move your cursor to position angle and left-click to place.
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6. Repeat the above steps but instead of clicking the horizontal reference line first, start by left-clicking the
vertical reference line followed by the horizontal line. Depending on order of reference line you click first,
you can define interior/exterior angle e.g. below.

 

Text
See also:

Insert text (manually)
Text box

The  Text  tool   enables  you  to  annotate  your  drawings  using  a  standard  text  box  style  interface.
Selecting the Text tool provides placement options in the Tool Options Catalogue which can be added to
your drawing by clicking on the location you want to place the text on the page.
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The text can then be entered into the text dialogue box with full control over font, size, style etc. The text tool
can also be used to enter system information by using an Autotext field to add project information you may
have entered in the Project Properties dialog box or through the Project Assistant when you started a new
project. This project information can be set up at any time in the Project Properties dialog box.

There  are  options  for  the  display  of  text  in  the  Tool  Options  Header  Bar.  You  can  modify  text  before
inserting it  in to your  drawing but  text  that  has already been inserted can also be modified at  any stage in
your project. Just select text by left-clicking it (see Selection Tool) (ensure you are on correct floor and the
text  is  not  protected/locked  from  further  editing)  and  use  the  options  in  the  Tool  Options  Header  Bar.
Because the text has already been inserted in to your drawing, on selection, additional options may become
available in the Tool Options Header Bar e.g.

By right-clicking placed text  on sheet,  you can also access these options directly  in  the context  menu that
appears.  Other  options  are  also  available.  The  context  menu  also  includes  an  entry  for  Properties.  This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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By right-clicking placed dimension on sheet, you can also access these options directly in the context menu
that appears. Other settings are also available. The context menu also includes an entry for Properties. This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.
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Insert text (manually)

1. From the left tool menu bar click the icon for Texts and Labels 

2. In the Text catalog on right of screen, left-click the icon for Insert text. 

3. In 2D mode, place your cursor in your desired position where you would like the text to go and left-click.

4. A dialog box will appear.
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5.  In the empty space, type in text required using your keyboard.

6. Font, style, size etc can all be changed within this dialog box.

7. After entering text, press the OK button to place text in position.

8. Placed text can be picked up and moved using the Selection tool 

9. You can also left-click text and in the Tool Options Header bar click the tab for Text.

10.This will open up same dialog box as before where you can amend text, font, style, size etc

Note: As described in the wall topics, automatic room labels e.g. above confirm that all of your walls connect,
with no gaps or spaces, to form a fully contained room. Room labels generated automatically are treated
separately to any text you have entered manually and can be switched on/off using the Automatic text
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on/off icon found in the status bar. You can also turn off individual room labels by left-clicking room
followed by the Room data tab in the Tool Options Header bar. In dialog box that appears, uncheck box for
Display in the plan.

Text box

1. From the left tool menu bar click the icon for Texts and Labels 

2. In the Text catalog on right of screen, left-click the icon for Text box. 

3. In 2D mode, place your cursor in your desired position where you would like the text box to go and
left-click to set the first reference point of text box.

4. Move cursor to draw out box.

5. Left-click again to set the second reference point of text box.

6. The text cursor will appear flashing at start of text box.

7. Using your keyboard type in text required and finish be pressing the Esc key.
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8. Placed text can be picked up and moved using the Selection tool 

9. You can also double left click text, highlight it and in the Tool Options Header bar click the tab for Text.

10.This will open up a dialog box where you change its font, style, size etc.

2D Drawing Tools
See also

Arbitrary line
Any line parallel to a reference line at a fixed distance
Polygon
Polygon at fixed width
N-Gon
Rectangle
Rotated rectangle
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Circle about center point and radius 
Circle through two opposite points
Circle through three points
Arc clockwise and Arc counter clockwise
Arc through three points 
Ellipse
Rectangle circumscribing ellipse
Ellipse defined by two axes
Elliptical arc clockwise and Elliptical arc counterclockwise
Bezier curve
Spline
Freehand line

Selecting the 2D drawing tools  (Lines, Ellipses, Arches and Rectangles)  from the Tool Menu Bar
displays a large selection of items in the Tool Options Catalog.
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Plans, cross-sections and elevations can be enhanced with additional line detailing by using the 2D Drawing

Tools . A series of line styles and types is available in the Tool Options Catalog and the presentation
including line style,  hatching,  colour  and line thickness can be fully  customized through the options  in  the 
Tool Options Header Bar. You can modify a 2D drawing element before inserting it in to your drawing but
drawing elements that have already been inserted can also be modified at any stage in your project. In your
worksheet just select a drawing element by left-clicking it  (see Selection Tool)  (ensure you are on correct
floor and the element is not protected/locked from further editing) and use the options in the Tool Options
Header Bar.  Because the 2D drawing element has already been inserted in  to your  drawing,  on selection,
additional options become available in the Tool Options Header Bar e.g.
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By right-clicking placed 2D element on sheet, you can also access these options directly in the context menu
that appears. Other options are also available. The context menu also includes an entry for Properties. This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.

See also Guidelines

Arbitrary line

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Arbitrary line.
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3. On your work sheet, set the starting point of the line with one left-click then drag the line into your desired
position and left-click once to set the end point of the line.

Note: After your first point is set, you can set the lines length more accurately by typing the number in on
your keyboard. The Distance field in the Numeric input bar at bottom of screen will highlight. In addition, if
you’d like to set the angle of the line, press the Tab key straight after entering the length. The Angle field in
the Numeric input bar at bottom of screen will highlight. To confirm settings, press Enter key or click the
Apply button.

Any line parallel to a reference line at a fixed distance

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Any line parallel to reference line at a
fixed distance.
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3. Left click on the wall you’d like a parallel line to.

4. The Tool options dialog box will appear where you enter the offset distance. Enter value and press the
OK button.

5. A green guideline will appear parallel to the wall (reference line). Using your mouse you can position this
either side of reference line. Left-click once to secure this lines position.
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6. Left-click to set the start point of the line.

7. Left click again to set the end point of the line.
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Polygon

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Polygon.

3. Set your start point with one left-click.

4. Move your cursor to the next point to create your first line and left-click.

5. From here, move out your cursor again and left-click to create another line that is connected to the one
before.

6. Repeat this in order to draw continuous lines.
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7. Complete drawing continuous lines by pressing the Esc key or by right-clicking and selecting Complete
element (up to last line drawn) in the context menu that appears. In same menu, the option for Close
element will automatically draw a line from end point of last line drawn to the start point of first line drawn. 

Note: In between each left-click (setting new lines), you can set the lines length more accurately by typing
the number in on your keyboard. The Distance field in the Numeric input bar at bottom of screen will
highlight. In addition, if you’d like to set the angle of the line, press the Tab key straight after entering the
length. The Angle field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press
Enter key or click the Apply button.

Polygon at fixed width

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Polygon at fixed width.

3. Click the Tool options icon in the top header bar. 

4. In the dialog box that appears you can determine the width of polygon in the Width field. Enter value and
close box.
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5. Set your start point with one left-click.

6. Move your cursor to the next point and left-click to create polygon at specified width.

7. With mouse, continue drawing out polygon to next point and left-click e.g. 

8. Repeat this as many times and complete drawing by pressing the Esc key or by right-clicking and
selecting Complete element (up to last line drawn) in the context menu that appears.

Note: In between each left-click, you can set the length of polygon more accurately by typing the number in
on your keyboard. The Distance field in the Numeric input bar at bottom of screen will highlight. In addition, if
you’d like to set the angle of the line, press the Tab key straight after entering the length. The Angle field in
the Numeric input bar at bottom of screen will highlight. Enter angle and confirm settings by pressing Enter
key or click the Apply button.



Construction Mode Tool Menu Bar

266

N-Gon

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for N-Gon.

3. In the Tool Options Header bar click the tab for N-Gon

4. The following dialog box will open to change number of corners/sides together with other properties.

5. Set the first point with one left-click which will determine the middle point of the N-Gon.

6. Move cursor outwards to specify radius of N-Gon.
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7. Again, just before you left-click to confirm the distance you can enter the radius more accurately by typing
the number in on your keyboard. The Distance field in the Numeric input bar at bottom of screen will
highlight. To confirm settings, press Enter key or click the Apply button.

8. Lastly, move your cursor to rotate the N-Gon. Press Enter key to confirm the position.

Rectangle

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Rectangle.
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3. Specify the first corner point of the rectangle with one left-click.

4. As you move mouse cursor, the rectangle will form automatically. Enter the second corner point of the
rectangle to complete it.

Rotated rectangle

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Rotated rectangle.

3. Left-click to set the pivot point of the rectangle.
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4. Move cursor followed by second left-click to specify width and rotation of rectangle or type value in directly
using your keyboard. The Distance field in the Numeric input bar at bottom of screen will highlight. To set
the angle, press the Tab key and the Angle field in the Numeric input bar at bottom of screen will highlight.
Enter angle and confirm settings by pressing Enter key or click the Apply button.

5. Finally drag out your cursor followed by a third left-click to set the height and position rectangle or type
value in directly using your keyboard. The Distance field in the Numeric input bar at bottom of screen will
highlight. Confirm settings by pressing Enter key or click the Apply button.

6.
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Circle about center point and radius

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Circle about center point and radius.

3. Left-click to set the center point of the circle.

4. Move cursor followed by a second left-click to set size of circle or you can enter the radius more accurately
by typing the number in on your keyboard. The Distance field in the Numeric input bar at bottom of screen
will highlight. To confirm settings, press Enter key or click the Apply button.

Circle through two opposite points

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Circle through two opposite points.

3. Left-click to set the first reference point for creating the circle.

4. Move cursor followed by a second left-click to set diameter of circle or you can enter the diameter more
accurately by typing the number in on your keyboard. The Distance field in the Numeric input bar at
bottom of screen will highlight. To confirm settings, press Enter key or click the Apply button.

Circle through three points

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Circle through three points.

3. Left-click to set the first reference point for creating the circle.
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4. Move cursor followed by a left-click to specify second reference point for creating the circle.

5. Next, move cursor followed by a left-click to set the third reference point to determine final size and
position of circle.

Note: Between clicks you can enter the sizes more accurately by typing the number in on your keyboard.
The Distance field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press
Enter key or click the Apply button.

Arc clockwise and Arc counterclockwise

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Arc clockwise or Arc counterclockwise.

3. First, left-click to set the center point of the arc.

4. Move your cursor to set the radius.

5. Left-click to set the starting point of the arc.

6. Finally, move your cursor to set the end point required e.g. below and left-click to complete arc.
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Arc through three points

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Arc through three points.

3. First, left-click to set the starting point of the arc.

4. Now set the end point of the arc with a second left-click.

5. Move cursor (arc will attach itself to cursor) to define the final curve and left-click again to complete arc.
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Ellipse

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Ellipse.

3. Left-click to set the center point of the Ellipse.

4. Move your cursor to determine shape and size of ellipse based on the reference point e.g. below and
left-click to place ellipse in position
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Rectangle circumscribing ellipse

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Rectangle circumscribing ellipse.

3. Left-click to set the first corner point of the rectangle.

4. Move your cursor to draw out rectangle and left-click to set the second corner point of rectangle to
complete the ellipse. 

Ellipse defined by two axes

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Ellipse defined by two axes.

3. First, left-click to set the center point of the ellipse.

4. Move your cursor followed by a left-click to set the height and first axis point of the ellipse.

5. Finally move your cursor followed by a left-click to set the width and second axis point of the ellipse.



3D Architect Home Designer

275

Elliptical arc clockwise and Elliptical arc counterclockwise

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Elliptical arc clockwise or Elliptical arc
counterclockwise.

3. First, left-click to set the center point of elliptical arc.

4. Move your cursor to set the radius.

5. Left-click to set the starting point of the elliptical arc.
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6. Finally, move your cursor to set the end point required e.g. below and left-click to complete elliptical arc.

Bezier curve

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Bezier curve.
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3. First, left-click to set the first reference point of rectangle.

4. Next, left-click to set the second reference point of rectangle.

5. Left-click again to set the third reference point of rectangle.

6. Finally, left-click to set the fourth reference point of the rectangle to complete bezier curve.

Spline

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Spline

3. First, left-click to set the starting point of the spline.
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4. Draw out line and set the second spline point with a left-click.

5. Move your cursor to create a curve on spline point. 

6. With a right-click you can also set a point in spline and manipulate curve at that point by moving your
cursor. Using this method, a line will attach itself to end of curve e.g. below and will alter in length and
direction when moving the cursor.

7. Left-click and continue drawing out spline and adding as many points as required.

8. To complete spline up to last click, press the Esc key or finish by setting last spline point with a left-click
whilst pressing the Ctrl key at same time.

Freehand line

1. From the left tool menu bar click the 2D drawing tools for (Lines, Ellipses, Arches and Rectangles)

2. In the Drawing catalog on right of screen, left-click the icon for Freehand line
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3. On work sheet, left-click and hold down the left mouse button and move the cursor to create a freehand
line.

4. If you let go of the left mouse button, you can now move your cursor elsewhere without trailing a line.

5. By holding the left mouse button down again, a new freehand line can be formed.

6. This feature can be used for quick free hand sketches for example.

Guidelines
See also

Arbitrary line (guideline)
Any line parallel to a reference line at a fixed distance (guideline)
Polygon (guideline)
Polygon at fixed width (guideline)
N-Gon (guideline)
Rectangle (guideline)
Rotated rectangle (guideline)
Circle about center point and radius (guideline)
Circle through two opposite points (guideline)
Circle through three points (guideline)
Arc clockwise and Arc counterclockwise (guideline)
Arc through three points (guideline)
Ellipse (guideline)
Rectangle circumscribing ellipse (guideline)
Ellipse defined by two axes (guideline)
Elliptical arc clockwise and Elliptical arc counterclockwise (guideline)
Bezier curve (guideline)
Spline (guideline)
Freehand line (guideline)

Selecting the Guideline Options icon  from the Tool Menu Bar displays a large selection of items in
the Tool Options Catalog.
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A series of guideline styles and types is available in the Tool Options Catalog. The icons are the same as
the 2D drawing icons so in case you select the wrong tools, the word (Guideline) is used in label to help
differentiate between the two. You use guidelines in the same as you would use the 2D drawing tools except
guidelines are just that. They are guides used prior to drawing in construction elements in order to help you
with accurate positioning quickly and easily. Unlike 2D drawing elements such as lines and rectangles,
guidelines will not appear on any printouts.

The presentation of line style, hatching, colour and line thickness can be fully customized through the options
in the Tool Options Header Bar.  You can modify a guideline before inserting it in to your drawing but
guideline elements that have already been inserted can also be modified at any stage in your project. In your
worksheet just select a guideline element by left-clicking it (see Selection Tool) (ensure you are on correct
floor and the element is not protected/locked from further editing) and use the options in the Tool Options
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Header Bar. Because the guideline has already been inserted in to your drawing, on selection, additional
options may become available in the Tool Options Header Bar e.g.

By right-clicking placed guideline on sheet, you can also access these options directly in the context  menu
that appears. Other options are also available. The context menu also includes an entry for Properties. This
opens a  Properties  dialog box  specific  to  that  element  and  comprises  of  a  number  of  tabs  for  accessing
same options in Tool Options Header Bar above.

See also 2D Drawing Tools

Arbitrary line (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Arbitrary line (guideline)
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1. On your work sheet, set the starting point of the line with one left-click then drag the line into your desired
position and left-click once to set the end point of the line.

Note: After your first point is set, you can set the lines length more accurately by typing the number in on
your keyboard. The Distance field in the Numeric input bar at bottom of screen will highlight. In addition, if
you’d like to set the angle of the line, press the Tab key straight after entering the length. The Angle field in
the Numeric input bar at bottom of screen will highlight. To confirm settings, press Enter key or click the
Apply button.

Any line parallel to a reference line at a fixed distance (guideline)
An easy and accurate method is to use guidelines to plan out your building, even before placing the first wall.
These can be used also for pegging out your plot or for accurately inserting other elements in to your plan.

There are a number of guideline options but one of most useful ones is Parallel to reference line (guideline)
for spacing your guidelines at exact distances. Practice using this somewhere in your plan by following the
example steps below:

1. From the left tool menu bar click the icon Guideline Options 

2. Place a single guideline (see Arbitrary line (guideline) ) to use as reference line followed by a second
click to set guideline in position.
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Note: You can also click on an element e.g. wall to use as reference line you would like parallel line to.

3. In the Guidelines catalog on right of screen, left-click the icon for Parallel to a reference line (guideline)

4. With this selected, click on the reference guideline you just placed (cursor will snap to the reference line)
to display the following Tool options dialog box.

5. Here you can enter the offset distance e.g. 5 ft

6. Move the mouse cursor either side of reference guideline where you want the guideline placed (highlighted
green) and then left-click to place guideline in position.
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7. You will now have two guidelines in place with an exact distance of e.g. 5 ft between them. With these in
place you can accurately draw in a wall for example by using one guideline as start point of wall and then
the other as end point of e.g. below.

Note: If the reference line/element does not highlight red then it's possible you will have to make some
changes in the Snap dialog box (menu item Options > Snap). There are a number of settings in the Snap
dialog box but the most common cause for snap not working in 2D is if the 'Snap only in current layer' box

Polygon (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Polygon (guideline)
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3. Set your start point with one left-click.

4. Move your cursor to the next point to create your first line and left-click.

5. From here, move out your cursor again and left-click to create another line that is connected to the one
before.

6. Repeat this in order to draw continuous lines.

7. Complete drawing continuous lines by pressing the Esc key or by right-clicking and selecting Complete
element (up to last line drawn) in the context menu that appears. In same menu, the option for Close
element will automatically draw a line from end point of last line drawn to the start point of first line drawn. 

Note: In between each left-click (setting new lines), you can set the lines length more accurately by typing
the number in on your keyboard. The Distance field in the Numeric input bar at bottom of screen will
highlight. In addition, if you’d like to set the angle of the line, press the Tab key straight after entering the
length. The Angle field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press
Enter key or click the Apply button.

Polygon at fixed width (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Polygon at fixed width (guideline)

3. Click the Tool options icon in the top header bar. 
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4. In the dialog box that appears you can determine the width of polygon in the Width field. Enter value and
close box.

5. Set your start point with one left-click.

6. Move your cursor to the next point and left-click to create polygon at specified width.

7. With mouse, continue drawing out polygon to next point and left-click e.g. 

8. Repeat this as many times and complete drawing by pressing the Esc key or by right-clicking and
selecting Complete element (up to last line drawn) in the context menu that appears.
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Note: In between each left-click, you can set the length of polygon more accurately by typing the number in
on your keyboard. The Distance field in the Numeric input bar at bottom of screen will highlight. In addition, if
you’d like to set the angle of the line, press the Tab key straight after entering the length. The Angle field in
the Numeric input bar at bottom of screen will highlight. Enter angle and confirm settings by pressing Enter
key or click the Apply button.

N-Gon (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for N-Gon (guideline)

3. In the Tool Options Header bar click the tab for N-Gon

4. The following dialog box will open to change number of corners/sides together with other properties.
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5. Set the first point with one left-click which will determine the middle point of the N-Gon.

6. Move cursor outwards to specify radius of N-Gon.

7. Again, just before you left-click to confirm the distance you can enter the radius more accurately by typing
the number in on your keyboard. The Distance field in the Numeric input bar at bottom of screen will
highlight. To confirm settings, press Enter key or click the Apply button.

8. Lastly, move your cursor to rotate the N-Gon. Press Enter key to confirm the position.
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Rectangle (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Rectangle (guideline)

3. Specify the first corner point of the rectangle with one left-click.

4. As you move mouse cursor, the rectangle will form automatically. Enter the second corner point of the
rectangle to complete it.
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Rotated rectangle (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Rotated rectangle (guideline)

3. Left-click to set the pivot point of the rectangle.
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4. Move cursor followed by second left-click to specify width and rotation of rectangle or type value in directly
using your keyboard. The Distance field in the Numeric input bar at bottom of screen will highlight. To set
the angle, press the Tab key and the Angle field in the Numeric input bar at bottom of screen will highlight.
Enter angle and confirm settings by pressing Enter key or click the Apply button.

5. Finally drag out your cursor followed by a third left-click to set the height and position rectangle or type
value in directly using your keyboard. The Distance field in the Numeric input bar at bottom of screen will
highlight. Confirm settings by pressing Enter key or click the Apply button.

6.



Construction Mode Tool Menu Bar

292

Circle about center point and radius (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Circle about center point and radius
(guideline)

3. Left-click to set the center point of the circle.

4. Move cursor followed by a second left-click to set size of circle or you can enter the radius more accurately
by typing the number in on your keyboard. The Distance field in the Numeric input bar at bottom of screen
will highlight. To confirm settings, press Enter key or click the Apply button.

Circle through two opposite points (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Circle through two opposite points
(guideline)

3. Left-click to set the first reference point for creating the circle.

4. Move cursor followed by a second left-click to set diameter of circle or you can enter the diameter more
accurately by typing the number in on your keyboard. The Distance field in the Numeric input bar at
bottom of screen will highlight. To confirm settings, press Enter key or click the Apply button.

Circle through three points (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Circle through three points
(guideline)

3. Left-click to set the first reference point for creating the circle.
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4. Move cursor followed by a left-click to specify second reference point for creating the circle.

5. Next, move cursor followed by a left-click to set the third reference point to determine final size and
position of circle.

Note: Between clicks you can enter the sizes more accurately by typing the number in on your keyboard.
The Distance field in the Numeric input bar at bottom of screen will highlight. To confirm settings, press
Enter key or click the Apply button.

Arc clockwise and Arc counterclockwise (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Arc clockwise and Arc
counterclockwise (guideline)

3. First, left-click to set the center point of the arc.

4. Move your cursor to set the radius.

5. Left-click to set the starting point of the arc.

6. Finally, move your cursor to set the end point required e.g. below and left-click to complete arc.
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Arc through three points (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Arc through three points (guideline)

3. First, left-click to set the starting point of the arc.

4. Now set the end point of the arc with a second left-click.

5. Move cursor (arc will attach itself to cursor) to define the final curve and left-click again to complete arc.
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Ellipse (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Ellipse (guideline)

3. Left-click to set the center point of the Ellipse.

4. Move your cursor to determine shape and size of ellipse based on the reference point e.g. below and
left-click to place ellipse in position.
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Rectangle circumscribing ellipse (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Rectangle circumscribing ellipse
(guideline)

3. Left-click to set the first corner point of the rectangle.

4. Move your cursor to draw out rectangle and left-click to set the second corner point of rectangle to
complete the ellipse. 

Ellipse defined by two axes (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Ellipse defined by two axes
(guideline)

3. First, left-click to set the center point of the ellipse.

4. Move your cursor followed by a left-click to set the height and first axis point of the ellipse.
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5. Finally move your cursor followed by a left-click to set the width and second axis point of the ellipse.
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Elliptical arc clockwise and Elliptical arc counterclockwise (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Elliptical arc clockwise and Elliptical
arc counterclockwise (guideline)

3. First, left-click to set the center point of elliptical arc.

4. Move your cursor to set the radius.
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5. Left-click to set the starting point of the elliptical arc.

6. Finally, move your cursor to set the end point required e.g. below and left-click to complete elliptical arc.
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Bezier curve (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Bezier curve (guideline)

3. First, left-click to set the first reference point of rectangle.

4. Next, left-click to set the second reference point of rectangle.

5. Left-click again to set the third reference point of rectangle.

6. Finally, left-click to set the fourth reference point of the rectangle to complete bezier curve.
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Spline (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Spline (guideline)

3. First, left-click to set the starting point of the spline.

4. Draw out line and set the second spline point with a left-click.
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5. Move your cursor to create a curve on spline point. 

6. With a right-click you can also set a point in spline and manipulate curve at that point by moving your
cursor. Using this method, a line will attach itself to end of curve e.g. below and will alter in length and
direction when moving the cursor.

7. Left-click and continue drawing out spline and adding as many points as required.

8. To complete spline up to last click, press the Esc key or finish by setting last spline point with a left-click
whilst pressing the Ctrl key at same time.

Freehand line (guideline)

1. From the left tool menu bar click the icon for Guideline Options 

2. In the Guidelines catalog on right of screen, left-click the icon for Freehand line (guideline)

3. On work sheet, left-click and hold down the left mouse button and move the cursor to create a freehand
guideline.

4. If you let go of the left mouse button, you can now move your cursor elsewhere without trailing a guideline.

5. By holding the left mouse button down again, a new freehand guideline can be formed.
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Symbols

Selecting  the  Symbols  tool   from  the  Tool  Menu  Bar  displays  a  large  selection  of  symbol  types
currently in the database, which can be chosen from the Tool Options Catalogue.
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In  the  catalog,  those  icons  identified  with  a  small  yellow  windows  folder  symbol  can  be  accessed  by  left-
clicking to reveal  the subset  of  options.  Depending on what tool  you  are  accessing,  there  could  be further

sub-folders  to  click.  With  the  following  icon  you  can  move  up  one  folder  in  the  directory  structure.  By

clicking the  icon you always move first into the folder that was last opened and by clicking the icon next

to it  returns you back to top of directory.
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Example symbols

3D Architect Home Designer contains a database of Symbols   which can be added to your drawings
using the standard drag and drop method from the Tool Options Catalogue. The symbols can be used to
add detailing to floor plans and elevations and can be used to show structural details such as wall insulation,
scaling information including people and decorative information such as plant outlines and vehicle symbols.
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Heating, Electrics & Sanitary

Selecting the Heating, Electrics & Sanitary tool  from the Tool Menu Bar displays a large selection of
symbol types currently in the database, which can be chosen from the Tool Options Catalogue.
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3D Architect Home Designer contains a database of symbols specifically for Heating, Electrics & Sanitary

 which can be added to your drawings using the standard drag and drop method from the Tool Options
Catalogue.  The  symbols  can  be  used  to  add  detailing  to  floor  plans  and  elevations  and  can  be  used  to
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display  electrical  component  positioning,  heating  elements  and  the  location  of  sanitary  ware  within  the
designs.
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3D Furnishing Mode Tool Menu Bar
3D Furnishing Mode can be accessed at any time to view the project you are working on in 3D. The main
use  of  the 3D Furnishing Mode  is  to  add  furniture,  fixtures,  fittings  and  decoration  with  a  combination  of
objects and textures from the catalogue.

Selection

Editing Tools

Objects

Materials

Selection

The standard  Selection  tool  is  accessed  from the Tool  Menu Bar  on  the left  hand  side of  the screen  by

clicking the Selection icon .

This is the normal default cursor that would be used when no other tool  is currently selected. To select an
element already entered within the project, using the Selection tool, left click on the element. The selected
element can then be amended and edited as required.

Using the same tool it is also possible to select multiple elements at the same time. There are two options to
selecting multiple elements: Firstly, holding down either the Shift or CTRL key whilst left-clicking your mouse
will enable you to select more than one element as a time. The other option is to use a ‘selection area’.

To create a selection area simply left-click your mouse on the page (not a drawing element) and hold down
the mouse button. Now drag the mouse to the opposite diagonal corner, ensuring that  the virtual rectangle
that  you  create  encompasses the object(s)  you  wish  to  select.  Once  you  have  everything  inside  the  area,
release the left mouse button and everything within the chosen area will be selected.

Note: This same selection tool can also be used for zooming by selecting this in the Tool Options circled

below.
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See also

Basic Mouse & Keyboard Controls
2D Construction Mode
3D Furnishing Mode

Editing Tools

Click on the Editing Tools icon  on the Tool Menu Bar. All available tools can be accessed from Tool
Options Catalog.

The editing tools in 3D Furnishing mode will be different to those in 2D Construction and Plan mode.

3D Furnishing Mode Editing Tools
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The catalog consists of a number of different tools for making changes to the model and scene in 3D
Furnishing mode. Tools include an advanced material editor, tools for moving, rotating and scaling textures
on model and tools for applying shading and reflection effects to model and ground area.

The editing tools also appear in the fly-out menu area when you hover your mouse cursor over icon. The
tools available  here are a selection of  the last  used editing tools,  allowing  easy access to  commonly  used
tools.

Edit material
Enter topic text here.

Move texture
Enter topic text here.

Scale Texture
Enter topic text here.

Rotate Texture
Enter topic text here.
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Reflections
Enter topic text here.

Shadows
Enter topic text here.

Background Brush
Enter topic text here.

Objects

In 3D Architect Home Designer furniture, fittings, exterior features and decorative items are accessed from

the Tool Options Catalogue when selecting the Objects icon . The objects database contains a large
volume of individually modeled 3D objects for use in your projects.

In  the  catalog,  those  icons  identified  with  a  small  yellow  windows  folder  symbol  can  be  accessed  by  left-
clicking to reveal  the subset  of  options.  Depending on what tool  you  are  accessing,  there  could  be further

sub-folders  to  click.  With  the  following  icon  you  can  move  up  one  folder  in  the  directory  structure.  By

clicking the  icon you always move first into the folder that was last opened and by clicking the icon next
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to it  returns you back to top of directory.

The objects in the database make use of Eleco’s own o2c file format. The o2c format enables 3D objects to
be greatly compressed, allowing the use of multiple objects in a project whilst maintaining small file sizes for
project  files.  Objects  can  be  placed  in  to  your  project  (either  in  2D  or  3D  mode)  using  the  drag  and  drop
method. They can then be scaled, rotated and moved as required.

For more information on the o2c player please see our dedicated o2c website at www.o2c.de/en

Materials

Materials  consist of patterns, colours, textures and images that can be applied to elements within the
3D model to create a visual representation of the proposed design. Materials consist of one or more bmp/jpg
images that can be added to an element using the normal drag and drop method. They can then be scaled,
rotated and moved as required.

3D  Architect  Home  Designer  uses  a  database  to  store  the  Materials  and  there  are  several  thousand  to
choose from. The Materials database is displayed in the Tool Options Catalogue once the Materials icon
is selected. New materials can be added to the database quickly, enabling you to easily expand the choices
available to you.

Hovering your mouse over the Materials icon will also display recently used materials which can be selected
directly from the fly-out menu.

http://www.o2c.de/en
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In  the  catalog,  those  icons  identified  with  a  small  yellow  windows  folder  symbol  can  be  accessed  by  left-
clicking to reveal  the subset  of  options.  Depending on what tool  you  are  accessing,  there  could  be further

sub-folders  to  click.  With  the  following  icon  you  can  move  up  one  folder  in  the  directory  structure.  By

clicking the  icon you always move first into the folder that was last opened and by clicking the icon next

to it  returns you back to top of directory.
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Terrain Brush
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Top Horizontal Icon Bar
Open

Save

Undo

Redo

Print

Export Image

Zoom to Rectangle

Show All

Construction Mode

3D Furnishing Mode

Plan Mode

Move Texture

Texture/Material Picker

Layer Selection Drop-Down

Floor Selection Drop-Down

Brightness Slider

Tool Options

Open

 Open  an  existing  3D Architect  Home Designer  project.  Launches  a  standard  Windows  file  browser
dialogue to enable you to locate the saved 3D Architect Home Designer (.anp) file.  Select  the required file
and left-click on Open.

This function can also be undertaken by selecting File – Open…

Save

 When you initially Save your file, you will be prompted by a standard Windows dialogue box to select
the  location  to  save  the  file  and  to  enter  a  filename.  Each  subsequent  save  of  the  file  will  use  the  same
filename and location.

This function can also be selected from File – Save… or CTRL + S on the keyboard.

Undo

 Clicking  Undo  reverses  the  most  recent  action,  reverting  your  drawing  to  the  state  prior  to  the  last
action. Undo can be used multiple times; each click will reverse the previous command. This enables you to
rollback a complete editing session if required.

This function can also be undertaken by selecting Edit – Undo or CTRL + Z on the keyboard.

An additional camera icon under the Undo button can be used to undo a move in viewpoint to the last used
view.
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Redo

 Redo  will  only be available  once an Undo  command has been used.  Redo  reverses the action of  a
previous undo, enabling you to remove and subsequently repeat  a command.  A Redo  will  be available  for
every equivalent undo used in an editing session.

This function can also be undertaken by selecting Edit – Redo or CTRL + Y on the keyboard.

An additional camera icon under the Redo button can be used to redo a move in viewpoint to the next used
view.

 

Print

 3D  Architect  Home Designer  lets  you  Print  plan  views,  elevations  or  perspective  views  directly  to  a
printer. Plan views are printed at a scale you specify, and perspective views at an adjustable size. In 2D you
open  the  standard  Windows  print  dialogue  box,  where  you  can  select  the  printer,  adjust  print  options
according to the selected printer, select the number of copies, and so on. In 3D there are additional options
to select the background colour and print resolution of the image.

This function can also be selected from File – Print or CTRL + P on the keyboard.

Export Image

 Exports  the  current  on-screen  view  to  an  Image  File.  All  standard  image  file  types  are  supported
including png, jpg, bmp and tif.

This function can also be selected from File – Export – Image File… or CTRL + B on the keyboard.

Zoom to Rectangle

 Zoom to an area defined by using a standard selection rectangle.

To create the selection rectangle, with your cursor left click at the point of the first corner (for example at the
top left) and then with the left mouse button held down, drag your cursor to the opposite diagonal corner (so
bottom right  in  this  example).  Release your  mouse button and the area selected  will  be  the zoomed area.
The smaller the selection rectangle, the greater the zoom effect.

This function can also be selected from View – Zoom – To Rectangle

Show All

 The view zooms to show the extent of all elements drawn in the project. This tool can be used to zoom
in  or  out  depending  on  your  current  view  point.  It  will  always  zoom  to  the  whole  project  filling  the  current
window and is usable in both 2D and 3D.

This function can also be selected from View – Zoom – Show All
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2D Construction Mode

 Toggles the view to the 2D Construction Mode. The blue bar indicates the current mode. Please be
aware that many tools and functions are related to the current mode in 3D Architect Home Designer.

3D Furnishing Mode

 Toggles the view into the 3D Furnishing Mode.  Please be aware that many tools and functions are
related to the current mode in 3D Architect Home Designer.

Plan Mode

 Toggle the view into Plan Mode to enable multiple views and different layouts to be combined in a plan
view. Please be aware that many tools and functions are related to the current mode in 3D Architect Home
Designer.

Move Texture

 Useable in 3D Furnishing Mode, selecting the Move Texture tool enables you to relocate the current
texture on the surface of the element. With the tool selected, move the cursor over the textured surface. Left-
click and hold down the mouse button whilst moving the mouse in the direction required. This is particularly
useful for textures with mortar and grout lines or tiling sections such as roof tiles.

Texture/Material Picker

 The  Texture/Material  Picker  is  a  two  step  tool  for  quickly  copying  a  texture  or  material  from  one
surface to another. Selecting the tool by clicking on the icon changes the cursor into a ‘texture picker’. With
this  icon,  locate  the  texture  on  your  plan  you  wish  to  copy  and  left-click.  The  texture  is  then  copied  and
converts the cursor to a ‘texture dropper’ icon. Now each surface you click on will have the selected texture
applied to it.

To  repeat  the process  with  a  different  texture,  press  Escape (Esc)  to  cancel  the  tool  and  then  repeat  the
process with the texture picker.

Layer Selection Drop-Down

 Select the currently active layer from the list of layers within the project.  Available layers
are selected from the drop down list.  You  can  also  access the New Layer  and  Manage Layers  functions
from the drop down menu.

Floor Selection Drop-Down

 Select the currently active floor from the list of floors within the project. Available floors are
selected from the drop down list. You can also access the New Floor and Create Variant functions from the



Top Horizontal Icon Bar

320

drop down menu.

Brightness Slider

 Sets the overall Brightness of the scene.

Tool Options

 Contains tool specific options based on the tool or element currently in use.
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Status Bar
Ruler On/Off

Grid On/Off

Sketch (Blur)

Manage Layers

Hatching On/Off

2D View Texture Overlay On/Off

Walk Through

Collision Control On/Off

Hide Facing Walls

Interior Objects On/Off

Exterior Objects On/Off

Roofs On/Off

Light Source Display

Shadow Display

Reflections Display

Use 3D Textures

Timber Construction On/Off

Room Labels On/Off

Edge Dimensions On/Off

North Point On/Off

Cameras On/Off

Configure Status Bar

Ruler On/Off

 Toggles the Ruler function on and off. The following will appear on the working page. Measurement units
displayed  on  the  ruler  can  be  changed  by  right-clicking  on  the  ruler  when  it  is  toggled  on.  You  can  then
choose various metric and imperial measurement units from the options available.
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You can also set the unit of measurement by right-clicking the ruler bar. Set the rulers origin position using
the Set zero point tool in the Editing tools catalog. With this tool selected, position zero point by clicking on
worksheet - the ruler origin position will be set according to this. 
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Grid On/Off

 Toggles the on-page Grid display on and off. When displayed the grid will present a snap target.

This function can also be toggled on and off using the menu option View – Grid. The settings for the grid are
available under Options – Grid.

Sketch (Blur)

 Toggles the Sketch mode drawing display on and off.

This function can also be toggled on and off using the menu option View – Sketch – As Sketch.

Manage Layers

 Toggles the Manage Layers dialogue box on and off.

This function can also be toggled on and off using the menu option Project – Manage Layers…
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Hatching On/Off

 Toggles the display of wall hatching patterns on and off.

2D View Texture Overlay On/Off

 Toggles the 2D Texture Overlay view on and off.

This function can also be toggled on and off using the menu option View – 2D Texture Overlay – Show.

Walk Through

 Enables  the  Walkthrough  mode  when  in  the  3D  view.  When  in  the  walkthrough  mode,  the  cursor
changes to a movement indicator based on the location on the screen. Holding down the left-mouse button
will move the viewer in the direction indicated, allowing for interactive views and tours of the design.

Moving  the  cursor  further  from  the  centre  of  the  screen  increases  the  speed  of  movement  in  the  chosen
direction.  Moving  the  cursor  closer  to  the  centre  of  the  screen  decreases  the  speed  of  movement  in  the
chosen direction.

Collision Control On/Off

Collision Control defines how the view behaves in Walkthrough mode when met with a solid element (e.g.
a wall). With collision control turned off, you are free to walk through walls and solid objects. When toggled
on, solid elements will block your movement, meaning entry to buildings can only be gained through opening
such as doors and windows.

Hide Facing Walls

 Toggles the Hide Facing Walls view option on and off. This option enables the walls facing the viewer to
be cut-away automatically to facilitate viewing of the interior.

This function can also be toggled on and off using the menu option View – Hide Facing Walls.

Interior Objects On/Off

 Toggles the display of interior furnishing models on and off.

Exterior Objects On/Off

 Toggles the display of exterior furnishing models on and off.

Roof Timber Display On/Off

 Toggles the roof timber construction display in project on and off.
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Light Source Display

 Toggles the display of the source of the lights used within the project on and off.

This function can also be toggled on and off using the menu option View – Light Source.

Shadow Display

 Toggles the display of shadows within the project on and off.

This function can also be toggled on and off using the menu option View – Shadows.

Reflections Display

 Toggles the display of reflections within the project on and off.

Use 3D Textures

 Toggles the display of 3D Textures on and off.

This  function  can  also  be  toggled  on  and  off  using  the  menu  option  View  –  Display  Quality  (3D)  –  3D
Textures.

Timber Construction On/Off

Toggles the display of the Timber Construction on and off.

This function can also be toggled on and off using the menu option View – Timber Construction.

Room Labels On/Off

 Toggles the display of all of the contents of the room data on and off. Text placed using the text tools is
not affected.

Edge Dimensions On/Off

 Toggles the display of the Edge Dimensions on and off. Manually added dimensions produced from the
Dimensions tool are not affected.

North Point On/Off

 Toggles the display of the North Point (compass) on and off.

This function can also be toggled on and off using the menu option View – North Point.
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Cameras On/Off

 Toggles the display of the location of the Cameras within the project on and off.

This function can also be toggled on and off using the menu option View – Cameras.

Configure Status Bar

 Launches the Configure Status Bar dialogue box. This enables you to select which toggle buttons to
show on the Status Bar as well as define the order in which they appear (top of the list in the dialogue box
appears furthest to the left on the status bar).
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